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Preface

Purpose of the Manual
This manual provides comprehensive information on Reydisp Evolution, getting started with Reydisp Evolution
and essential steps during engineering with Reydisp Evolution.

Target Audience
This manual is mainly intended for protection system engineers, commissioning engineers, persons entrusted
with the setting, testing and maintenance of automation, selective protection and control equipment, and
operational crew in electrical installations and power plants.

Scope
This manual applies to the Reyrolle Reydisp Manager 2 device family.

Further Documentation

[dw_7SR5_furtherdocumentation_engineeringguide, 1, en_US]

• Device manuals
Each device manual describes the functions and applications of a specific Reyrolle Reydisp Manager 2
device. The printed manual for the device has the same informational structure.

• Hardware manual
The hardware manual describes the hardware building blocks and device combinations of the Reyrolle
Reydisp Manager 2 device family.
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• Operating manual
The operating manual describes the basic principles and procedures for operating and installing the
devices of the Reyrolle Reydisp Manager 2 range.

• Communication protocol manual
The communication protocol manual contains a description of the protocols for communication within
the Reyrolle Reydisp Manager 2 device family and to higher-level network control centers.

• Product information
The product information includes general information about device installation, technical data, limiting
values for input and output modules, and conditions when preparing for operation. This document is
provided with each Reyrolle Reydisp Manager 2 device.

• Engineering Guide
The engineering guide describes the essential steps when engineering with Reydisp Manager 2. In addi-
tion, the engineering guide shows you how to load a planned configuration to a Reyrolle Reydisp
Manager 2 device and update the functionality of the Reyrolle Reydisp Manager 2 device.

• Virtual Relay
The virtual relay allows a user to view, control and manipulate a virtual Reydisp Manager 2 device. The
virtual relay is a tool that can facilitate training and understanding of the controls and functions on a
Reyrolle Reydisp Manager 2 device.

• Reyrolle Reydisp Manager 2 catalog
The Reyrolle Reydisp Manager 2 catalog describes the system features and the devices of Reyrolle Reydisp
Manager 2.

• Selection guide for Reyrolle and SIPROTEC
The selection guide offers an overview of the device series of the Siemens protection devices, and a
device selection table.

Additional Support
For questions about the system, contact your Siemens sales partner.

Customer Support Center
Our Customer Support Center provides a 24-hour service.
Siemens AG
Customer Support Center
Humboldtstrasse 59
90459 Nuremberg
Germany
E-mail: support.energy@siemens.com

Training Courses
Inquiries regarding individual training courses should be addressed to our Training Center:
Siemens AG Phone: +49 (911) 433-7415
Siemens Power Academy TD Fax: +49 (911) 433-7929
Humboldtstrasse 59 E-mail: poweracademy@siemens.com
90459 Nuremberg Internet: www.siemens.com/poweracademy
Germany

Notes on Safety
This document is not a complete index of all safety measures required for operation of the equipment (module
or device). However, it comprises important information that must be followed for personal safety, as well as
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to avoid material damage. Information is highlighted and illustrated as follows according to the degree of
danger:

! DANGER
DANGER means that death or severe injury will result if the measures specified are not taken.

² Comply with all instructions, in order to avoid death or severe injuries.

! WARNING
WARNING means that death or severe injury may result if the measures specified are not taken.

² Comply with all instructions, in order to avoid death or severe injuries.

! CAUTION
CAUTION means that medium-severe or slight injuries can occur if the specified measures are not taken.

² Comply with all instructions, in order to avoid moderate or minor injuries.

NOTICE
NOTICE means that property damage can result if the measures specified are not taken.

² Comply with all instructions, in order to avoid property damage.

ii NOTE
Important information about the product, product handling or a certain section of the documentation
which must be given attention.

Preface
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Open Source Software

The product contains, among other things, Open Source Software developed by third parties. The Open
Source Software used in the product and the license agreements concerning this software can be found in the
Readme_OSS. These Open Source Software files are protected by copyright. Your compliance with those
license conditions will entitle you to use the Open Source Software as foreseen in the relevant license. In the
event of conflicts between Siemens license conditions and the Open Source Software license conditions, the
Open Source Software conditions shall prevail with respect to the Open Source Software portions of the soft-
ware. The Open Source Software is licensed royalty-free. Insofar as the applicable Open Source Software
License Conditions provide for it you can order the source code of the Open Source Software from your
Siemens sales contact – against payment of the shipping and handling charges – for a period of at least 3
years after purchase of the product. We are liable for the product including the Open Source Software
contained in it pursuant to the license conditions applicable to the product. Any liability for the Open Source
Software beyond the program flow intended for the product is explicitly excluded. Furthermore any liability
for defects resulting from modifications to the Open Source Software by you or third parties is excluded. We
do not provide any technical support for the product if it has been modified.
The ReadmeOSS documents for the product can be found here: www.siemens.com/reyrolle
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What is Reydisp Manager 2?
Reydisp Manager 2 is the engineering tool for configuring and operating all 7SR5 devices. The functional
scope of Reydisp Manager covers all tasks – from device configuration and device setting to evaluation of fault
data.
The user can perform all configuration tasks offline from their PC without the need for a 7SR5 device. All data
can be transferred to the device online at a later date – for example, via a direct USB connection or a commu-
nication network.
The basic parameter settings can also be viewed and edited from the device fascia.
Reydisp manager 2 is available to download free of charge from the website www.siemens.com/reyrolle.
The Reyrolle 5 device template installer must also be downloaded and installed.
It provides the following features:

• Configure device functionality

• Configure device settings

• Create and edit logic diagrams

• Configure device IEC 61850 interface/time zone

• Create user-definable current/voltage/thermal curves

• Configure serial communication data points and fascia event log

• Edit IEC 61850 Stations using the optional System Configurator with seamless integration with Digsi

1.1

Reydisp Manager 2 Overview
1.1 What is Reydisp Manager 2?
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Engineering Philosophy and Terms
Offline

The following list provides an overview of the tasks the user can work with, among others, in the Offline
mode:

• Defining the functional scope of a 7SR5 device

• Setting function parameters

• Defining user curves

• Defining fascia display pages and mimic control

• Project engineering logic

• Defining serial data points and device event log

• Configuring the communication network and setting communication settings

• Displaying saved fault records and evaluating them with suitable viewing software

• Exporting configuration data and printing

Project
Reydisp Manager manages the components of a system and all the data associated with it in relation to the
project. The following information is collected under a project:

• Topology information

• Offline configuration of all 7SR5 devices

• Data contained in the offline configuration, for example:
– Parameter values
– Communication settings
– Process data

In other words, the user only has to open 1 project to have access to all data. Conversely, all changes are
saved simply by saving or closing the project.

Project Tree
When a project is opened in Reydisp Manager, the project is displayed in a hierarchical structure in the project
tree.

1.2

Reydisp Manager 2 Overview
1.2 Engineering Philosophy and Terms
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[sc_7SR5_ReydispManager2ProjectTree, 1, --_--]

Figure 1-1 Project Tree with Open Project

The icons and text boxes in the project tree provide access to all of the project data as well as the associated
device tasks. Examples of such actions include adding a 7SR5 device or transferring data to the 7SR5 device.

7SR5 Device
The 7SR5 device can be configured from the Reydisp Manager tool. Limited parameter changes can also be
made from the device fascia.
 

Physical Device
Every device has a product code. It specifies the device hardware and the base application software configura-
tion.
The fascia access keys allow parameter changes, input and output mappings, and functions to be enabled/
disabled.
 

Logical Functional Scope and Field of Application
The 7SR5 device provides all the necessary protection functions to address the application requirements
ensuring reliability and security of power transmission systems. However, the devices are not simply protec-
tion or electronic control units, but can also monitor, measure, log failures and much more.
The application of the 7SR5 device defines the functional scope of the device as well as the connections
between functions and hardware.
 

7SR5 Templates
To edit a 7SR5 device with Reydisp Manager, the user needs an image of the physical device in the project.
This image corresponds to the offline configuration of the device. The offline configuration contains all of the
data in the physical device.

Reydisp Manager 2 Overview
1.2 Engineering Philosophy and Terms
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[sc_7SR5_ReydispManager2ProjectTreeEntries, 1, --_--]

Figure 1-2 Entries in the Project Tree of an Opened Offline Configuration

 

Product Code
Reyrolle devices have a machine-readable product designation, abbreviated MLFB. The MLFB code designates
the hardware specification and the base application functionality.
 

Application
The application determines the base functional scope and the functionality of the device.

Details on Applications
The product code MLFB designates the hardware platform in the first 4 digits of the MLFB code, with the 5th
digit defining the base functionality.
The functionality available to a user is included in the device Function Template. Function templates
comprise of Function Groups (FG) and within each FG there may be a number of Function Elements
(FE).
7SR5 devices include a number of FG each containing a number of FE.
7SR5 device function groups and elements can be added or removed only by using the Reydisp Manager 2
(RM2) software configurator tool.
FG and FE that have been included from the Reydisp Manager configurator can be enabled/disabled.
The Default Function Template is the functionality included in the device when delivered from the
factory.
The RM2 settings tool is used to add or remove Function Groups and Function Elements from the
Default Function Template. It also allows the customization of the device to assign function elements
to specific analogue inputs in the device hardware when applicable. Customization of the Default Func-
tion Template is typically carried out during the engineering or installation phase of the project, prior to
commissioning of the device.

Reydisp Manager 2 Overview
1.2 Engineering Philosophy and Terms
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Function Groups and Function Elements
Using the RDM2 > Tasks > Device Functionality feature, default RM2 function templates are offered
for selection automatically when a new device is created in RM2.
The device is designed to allow all functions and elements visible in the Device Functionality feature to
be enabled in the device configuration.

Reydisp Manager 2 Overview
1.2 Engineering Philosophy and Terms
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User Interface
Functional Sections of the User Interface

The program structure of Reydisp Manager 2 is designed to optimally support the working steps required
during a project.
The user interface is divided into 6 functional sections and a menu bar:

• Menu bar

• Project tree

• Working area

• Device details

• Information workflow, messages, and alerts

• Tasks

• Device data

[dw_7SR5_ReydispManager2FunctionOverview, 1, en_US]

Figure 1-3 Reydisp Manager 2 Functional Section Overview

(1) Menu bar
(2) Project information
(3) Project tree
(4) Working area

 

1.3

Reydisp Manager 2 Overview
1.3 User Interface
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Project Tree
The project tree is positioned on the left side of the user interface and is the central element when working
with Reydisp Manager 2. The individual device icons and entries gives access to all data and tools.
This shows the name of the project, and the folder structure. The folder structure can be changed by dragging
folders to move them. The folder names and project name can also be renamed here. The project tree is used
to organize a project into logical folders and provides a quick way to navigate between folders.

[sc_7SR5_ReydispManager2EntriesInProjectTree, 1, --_--]

Figure 1-4 Reydisp Manager 2 Entries in the Project Tree

 

Menu Bar
The menu bar along the upper edge of the user interface contains access to File commands, a Tools, and a
Help option.

[sc_7SR5_ReydispManager2MenuBar, 1, --_--]

Figure 1-5 Reydisp Manager 2 Menu Bar

 

Reydisp Manager 2 Overview
1.3 User Interface

18 Reyrolle 7SR5, Engineering Guide, Manual
C53000-G7040-C013-1, Edition 04.2020



Tools
The tools menu provides an export of a Simple Network Time Protocol (SNTP) time server ICD template file.
By selecting the Export IEC 61850 SNTP menu the user can save the template SNTP ICD to a suitable file
location.
 

Help
The About select advises the version number of Reydisp Manager and provides a link to view details of the
Open Source Software information.

[sc_7SR5_ReydispManager2AboutRM2, 1, --_--]

Figure 1-6 Reydisp Manager 2 About Dialog Box

 

Working Area
The working area display will show the files or folders contained in the selected item in the tree view.
If a device is selected the display will show details of the device in the top section and contain the user files for
device configuration below.

[sc_7SR5_ReydispManager2WorkingArea, 1, --_--]

Figure 1-7 Reydisp Manager 2 Working Area

When a device is selected in the project tree view, the top section displays the device property information.
The central area lists the device configurable files and the lower section of the display provides links to the
available tasks, messages, and device data for the selected device.

Reydisp Manager 2 Overview
1.3 User Interface
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[dw_7SR5_ReydispManager2Tasks, 1, en_US]

Figure 1-8 Reydisp Manager 2 Tasks

(1) Project tree view
(2) Device details (Only appears when device is selected in project tree)
(3) Working area configuration files
(4) Task area
(5) Send files to device
(6) Get files from device

The default configuration includes:

• User setting file

• Logic file

• HMI screen

• Serial comms and events file
In addition a user curve can be added from the Project Tree > Add Curve function.

Reydisp Manager 2 Overview
1.3 User Interface
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[sc_7SR5_ReydispManager2AddCurve, 2, --_--]

Figure 1-9 Reydisp Manager 2 Add Curve

The device configuration files are edited using the following tools:

• Device Functionality editor for application function files

• Device Settings editor for device parameter files

• Comms Editor for serial comms and event files

• Reylogic Express for graphical logic files

• ReyMimic Editor for HMI screen files

• Curve Editor for curve files

 

Copy
The copy selection is for creating an exact copy of a fully configured device. The devices are copied from the
Project Tree > Copy function.

Reydisp Manager 2 Overview
1.3 User Interface
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[sc_7SR5_ReydispManager2Copy, 1, --_--]

Figure 1-10 Reydisp Manager 2 Copy

 

Paste
Paste is for adding a copy of a fully configured device into the project. The paste is found at the project folder
level and devices can be added within a project or copied from another project.

[sc_7SR5_ReydispManager2Paste, 1, --_--]

Figure 1-11 Reydisp Manager 2 Paste

The new device will be added into the project with a number in brackets if a device in that project already has
the same name.
 

Task Area
The task tab provides the following additional tools for general device configuration:

Reydisp Manager 2 Overview
1.3 User Interface
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[sc_7SR5_ReydispManager2TasksTab, 1, --_--]

Figure 1-12 Reydisp Manager 2 Task Tab

• Properties – This allows viewing and editing of the device properties including template version, serial
number, name, IEC 61850 edition, and IP address.

• Ethernet interface configuration

• Ethernet time zone configuration

ii NOTE
Some information will only become available after connection to the device.

You can open several tools simultaneously.
The task area also has 2 additional tabs, one for displaying the device data and one displaying the information
messages and warnings.
Within the task area are a number of additional features for updating and retrieving information from the
device.

• Device Data – Lists the data files when they have been downloaded from the device. They are saved to
the PC configuration. Files can also be deleted.

• Messages – Displays the message logs showing actions carried out as well as any user alert messages.
The messages can be cleared.

Overview of Editors
This chapter provides an overview of the editors that are needed for the tasks in this manual. This overview
also gives a quick idea of the required engineering steps for configuration. An exact description of the editors
can be found in the associated descriptions of procedures in this manual.

• Device Functionality
This editor is used to modify the application function file, for selecting the protection functions available
in the device and which analogue hardware inputs they are associated to.

• Device Settings
This editor is used for editing the device parameter file and allows changes to be made to the settings, for
example of protection functions. Certain functions, for example, for distance protection or tripping, can
be visualized graphically.

• Comms Editor
This editor is used for viewing and editing the serial protocol data specific to a device type and configura-
tion. It allows the user to establish which signals will be transmitted and the format of the data trans-
mitted. It also allows the configuration of the event data displayed in the device event log on the fascia.

• Reylogic Express
This editor is used for configuring the graphical logic files, and allows the user to configure additional
functions for the device. The user can create user logic with predefined gates and device signals.

• ReyMimic Editor
This editor is used for generating the HMI screens with a maximum of 5 display pages for use on a 7SR5
device display.
HMI screens can be copied and pasted between device configurations.

• Curve Editor
This editor allows the user to create custom curves. The curves are created and saved in the device
configuration.
Curves can be copied and pasted between device configurations.

Reydisp Manager 2 Overview
1.3 User Interface
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Overview of Engineering Steps
The first step is to create a new project. The procedure of the subsequent steps however, is not mandated,
although the configuration and changes of the Device Functions and Curve Editor may cause changes in the
other configuration files.
Siemens recommends the following order which can also be found in this manual:

• Starting Reydisp Manager 2 and creating a project
Whenever you begin engineering, you must first create a new project.

• Creating a project folder
Within the project the user can add folders to assist the file management.

• Adding a 7SR5 device
Each physical device in the system must also be represented in the associated project. A 7SR5 device can
be selected by choosing the correct MLFB order code from the create device tool. The user can select the
latest firmware version if the device firmware version is not known.

• Adjusting the functional scope
When adding a device to a project, the user will have already selected the basic application when
selecting the device template. By doing so, the device is already configured with an application-oriented
basic functional scope. The user can change these by adding or deleting function groups and function
elements. Function elements can also be assigned to the available analogue inputs from the selected
hardware.

• Creating user curves
Time graded elements can be customized with the addition of user defined curves. Depending on the
device selected, the option for adding Current, Voltage and Thermal curves is available. The user
curves will be included in the device parameters using the name given during the configuration steps.
This engineering step is optional. A device also works correctly without additional curves as the default
configuration will always contain the IEC and ANSI standard curves.

• Creating user logic
A device can be customized for specific application requirements using the user logic. Self-configured
functions can be created using logic symbols and device interface connection points. These can be used
for interlocking, control items and indications. The user logic can be used for the mapping of GGIO points
and mimic controllable plant items. This engineering step is optional. A device also works correctly
without creating any logic.

• Creating display pages
In the default configuration, the display of a 7SR5 device shows the Primary Current values. Upto 4
additional display pages can be created for each device. Different device information and selected
symbols can be used from a preconfigured library when configuring the display pages. The default
display page can also be modified by the user. This engineering step is optional. A device also works
correctly without self-created display pages.

• Device configuration parameters
To optimally adapt the device application to suit user requirements, set all protection function parame-
ters for the device, all device configuration, and mappings. This engineering step is essential as the
default settings have all elements disabled and do not include any tripping selection.

• Configuring communication
For a device to communicate using the serial protocols these must be set in the device parameters. To
ensure compatibility with SCADA the protocol mapping enabled must be configured. This step also allows
the selection of events to be displayed in the fascia Event Log. This engineering step is optional. A
device also works correctly without any user changes.

• Configuring Ethernet communication
For a device to communicate using the Ethernet communication the Ethernet Interface must be config-
ured. This includes the IP address when used as a stand alone device and the Redundancy and SNTP infor-
mation. This engineering step is optional depending upon the network configuration.

2.1

Essential Steps during Engineering
2.1 Overview of Engineering Steps
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• Configuring Ethernet time zone
For a device to communicate using the Ethernet communication the local time zone must be configured
with an option to set a summertime switch over time. Note the relay works on local time where the
Ethernet connection is on UTC. This engineering step is optional.

• Adding an IEC 61850 station
A station is an item that allows multiple IEC 61850 capable devices to be grouped together to allow them
to communicate with each other.

Essential Steps during Engineering
2.1 Overview of Engineering Steps
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Starting Reydisp Manager 2 and Creating a Project
Starting Reydisp Manager 2

In the Start menu under Reydisp Manager 2, select the program entry for the current Reydisp Manager 2
version.

[sc_7SR5_ReydispManager2ProjectScreen, 2, --_--]

Figure 2-1 Reydisp Manager 2 Startup Screen

Creating a New Project
Select the New Project option.

[sc_7SR5_ReydispManager2NewProject, 1, --_--]

Figure 2-2 Reydisp Manager 2 New Project

The Create New Project dialog opens.

2.2

Essential Steps during Engineering
2.2 Starting Reydisp Manager 2 and Creating a Project
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[sc_7SR5_ReydispManager2NewProjectDialog, 1, --_--]

Figure 2-3 Reydisp Manager 2 New Project Dialog

Enter the desired project name and path or accept the data suggested. A subdirectory is created for the project
in the selected location by default. The name is the same as the project name. This can be changed by
changing the text in the Directory text box. Untick the Create Directory For Project check box to
save the project file straight to the specified location without creating a subdirectory.
Click OK.

Open an Existing Project
Select the Open Project option.

[sc_7SR5_ReydispManager2OpenProject, 1, --_--]

Figure 2-4 Reydisp Manager 2 Open Project

Alternatively select a recent project from the list.

[sc_7SR5_ReydispManager2RecentProject, 2, --_--]

Figure 2-5 Reydisp Manager 2 Recent Project

A new project is created and saved in the standard directory for projects. The project is then displayed in the
project tree.

Essential Steps during Engineering
2.2 Starting Reydisp Manager 2 and Creating a Project
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[sc_7SR5_ReydispManager2NewProjectTree, 1, --_--]

Figure 2-6 Reydisp Manager 2 Project Tree

Exporting an Existing Project
Select the Export Project option.

[sc_7SR5_ReydispManager2ExportProject, 1, --_--]

Figure 2-7 Reydisp Manager 2 Export Project

The export project feature will add all of the files in the project to a .zip file for archiving or transferring to
another user.
The recent projects also have a direct export selection option, as shown in the following figure, at the end of
the project.

Essential Steps during Engineering
2.2 Starting Reydisp Manager 2 and Creating a Project
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[sc_7SR5_ReydispManager2DirectExport, 1, --_--]

Figure 2-8 Reydisp Manager 2 Direct Export

A Save As window is provided to select the name and location where the archive file is to be stored on the
PC. When the preferred name and location are entered click Save.

Essential Steps during Engineering
2.2 Starting Reydisp Manager 2 and Creating a Project
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Adding a Folder
Overview

To organize the project more effectively folders can be created which can contain other items, including addi-
tional folders.
A New Folder can be added to the project by:

• From the menu selecting File > Add New Folder
• Right-click on the project and select New Folder.

[sc_7SR5_ReydispManager2AddFolder, 1, --_--]

Figure 2-9 Reydisp Manager 2 New Folder

• The folder will be given a default name New Folder and will be selected to allow it to be renamed.

• A folder cannot be given the same name as an existing item in the same folder. It's name must be
unique.

• Folders may be nested to any required depth.

2.3
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Adding a 7SR5 Device
Overview

Inserting a 7SR5 Device into a Project
You can insert a device directly in the project tree with the aid of a valid product code. Everything specified by
this product code is created afterwards in Reydisp Manager 2.
The product code can be entered directly into the Device MLFB user entry box as a partial code or complete
code and the selection will be filtered automatically to assist the selection.
If the device is connected to the PC the product code can be provided from the device using the From
Connected Device option.
You can also import the connected device into the project.

[sc_7SR5_ReydispManager2AddDevice, 1, --_--]

Figure 2-10 Reydisp Manager 2 Adding a Device

 

Create Device Tool
Using the Create Device tool, the basic configurations for new 7SR5 devices can be inserted into the
project.
 

Representations of the Device in the Project
When you insert a device into the project, you can find the device at various locations in the project:

2.4

Essential Steps during Engineering
2.4 Adding a 7SR5 Device

Reyrolle 7SR5, Engineering Guide, Manual 33
C53000-G7040-C013-1, Edition 04.2020



• Project tree
When the project is selected in the project tree the overview list of devices are displayed with basic prop-
erties and device status.

• Device view
When the device is selected in the project tree the Device view displays the device details, configuration
files, tasks, device data, and Information messages for the selected device.

Inserting a 7SR5 Device with the Product Code
You must know the product code for a physical 7SR5 device to create a 7SR5 device in Reydisp Manager 2. The
goal of this chapter is to create the project structure shown in the following figure.

[sc_7SR5_ReydispManager2ProjectFolder, 1, --_--]

Figure 2-11 Reydisp Manager 2 Project Folder

 

Overview of the Procedure
Perform the following actions:

• Add the 7SR5 device in the project folder.

• Enter the product code and select an application template firmware version.
 

Starting the Process
Either from the File Menu or by right-clicking on the folder and selecting New 7SR5 Device from the
Install template.
Alternatively the user can load a specific template from a file.
The New 7SR5 Device opens the Create Device window.
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[sc_7SR5_ReydispManager2NewDevice, 2, --_--]

Figure 2-12 Reydisp Manager 2 Inserting a New Device

 

Entering the Product Code and Selecting an Application Template
The tool allows the MLFB order code to be typed directly into the Filter input box if it is known, or the
device can be selected from the list window using the scroll bar.
If the MLFB order code is not known the drop down selections will reduce the number of device selections
according to the filters applied.
The tool provides filter options for the device application, if voltage inputs are required and the ethernet
connection type.
Select the product code from the list.
Alternatively enter the following product code in the Device MLFB: 7SR5110-1AA11-0AA0.
Click Next.
The product code entered is verified.

ii NOTE
Entering a partial MLFB will act as a filter on the selection list.

 

Getting the Product Code from a Connected Device
To add a device to the project which has the same model order code as a connected device, the Device MLFB
can be taken from the device and the template identified.
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Select the From Connected Device option , as shown in Figure 2-13.

[dw_7SR5_ReydispManager2ConnectedDevice, 1, en_US]

Figure 2-13 Reydisp Manager 2 From Connected Device

Enter the connection method and click OK.

[sc_7SR5_ReydispManager2ConnectionMethod, 1, --_--]

Figure 2-14 Reydisp Manager 2 Connection Method

The PC will connect to the device and get the MLFB ordering code information.
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[sc_7SR5_ReydispManager2ConnectingDevice, 1, --_--]

Figure 2-15 Reydisp Manager 2 Device Connecting

ii NOTE
If the connection fails a notification similar to the one shown in Figure 2-16 is given.
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[sc_7SR5_ReydispManager2ConnectionFailed, 1, --_--]

Figure 2-16 Reydisp Manager 2 Connection Failed

The device MLFB will be entered into the Device MLFB box and the templates filtered to display the correct
device. Select the device from the list.
Click Next to continue and proceed as described in this section.
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[sc_7SR5_ReydispManager2DeviceSelection, 1, --_--]

Figure 2-17 Reydisp Manager 2 Device Selection

 

Importing a Copy of a Connected Device to Add to A Project
Select Import connected device and click Next.
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[dw_7SR5_ReydispManager2ImportConnectedDevice, 1, en_US]

Figure 2-18 Reydisp Manager 2 Import Connected Device

Enter the connection method and click Next.

[sc_7SR5_ReydispManager2ConnectionMethod, 1, --_--]

Figure 2-19 Reydisp Manager 2 Connection Method

The PC will connect to the device and import a copy of the device.

ii NOTE
Any station association will be lost when the device is imported as a copy in to the project.
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[sc_7SR5_ReydispManager2ImportingCopyofDevice, 1, --_--]

Figure 2-20 Reydisp Manager 2 Importing Copy of Device
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[sc_7SR5_ReydispManager2ImportingCopyofDeviceFinish, 1, --_--]

Figure 2-21 Reydisp Manager 2 Finish Importing Copy of Device

Click Finish to complete the import copy and the device will now be shown in the project tree. The device
can now be added to the station if required. Refer to 2.13 Adding an IEC 61850 Station for guidance on
assigning the device to a station.

[sc_7SR5_ReydispManager2ImportedDeviceinProjectTree, 1, --_--]

Figure 2-22 Reydisp Manager 2 Imported Device in Project Tree
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Selecting An Application Template

[sc_7SR5_ReydispManager2SelectTemplate, 1, --_--]

Figure 2-23 Reydisp Manager 2 Selecting a Template

In the Select template list box, highlight the application version required of the template. The template
version also provides information regarding the minimum device firmware required for that device template.
Click Next.
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[sc_7SR5_ReydispManager2MinimumFirmware, 1, --_--]

Figure 2-24 Reydisp Manager 2 Minimum Firmware

After the desired device template is selected the display will now show the user both the configuration version
and the minimum firmware version required for the selected template. If correct select Next to continue or
Previous to return to the template version selection.
The user is prompted to enter the Device Name in the dialogue box.
Enter a suitable device name and click Next.
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[sc_7SR5_ReydispManager2DeviceName, 1, --_--]

Figure 2-25 Reydisp Manager 2 Device Name

ii NOTE
The device name can be changed after the device is created using the Rename feature or in the device
properties.

The user is prompted to enter the IEC 61850 IED name in the dialogue box.
Enter a suitable device name and click Next.
The IEC 61850 IED name is subject to the following restrictions:

• It may be a maximum of 13 characters.

• It may only contain the characters A-Z, a-z, 0-9 and _.

• It must start with a letter, not a digit or underscore.

• If the device is assigned to a station, an additional rule is imposed: The IED name cannot be the same as
another IED name assigned to that station.

Select from the drop down options the IEC 61850 Edition to be used on the device.
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[sc_7SR5_ReydispManager2SelectIECEdition, 1, --_--]

Figure 2-26 Reydisp Manager 2 Selecting IEC 61850 Edition

ii NOTE
The IEC 61850 IED name and edition number can be changed after the device is created using the device
properties.

The Create Device tool will proceed to construct the device with a default configuration.
Click Finish to complete.
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[sc_7SR5_ReydispManager2DeviceConstruction, 1, --_--]

Figure 2-27 Reydisp Manager 2 Device Construction

The project structure will now contain an additional offline configuration for the inserted 7SR5 device with a
basic default configuration. The device is now ready for user configuration.
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[sc_7SR5_ReydispManager2ProjectStructure, 1, --_--]

Figure 2-28 Reydisp Manager 2 Project Structure

This process should be repeated to add all devices to the project.
Selecting the device will populate the window with the device details, device files, tasks, and device data for
the device.
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[sc_7SR5_ReydispManager2SelectDevice, 1, --_--]

Figure 2-29 Reydisp Manager 2 Device Details
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Function Configuration
Overview

The protection, control and supervision functions that can be included in the device are dependent on the
7SR5 device type and it’s hardware configuration. The functionality available to a user is included in the device
Function Template and can be modified by the user by editing the Function Configuration using
the Application Functions tool in Reydisp Manager 2. In many cases, the selected application template
can be used without any change to the functional configuration. In addition, the functional scope of the appli-
cation, and thus of the 7SR5 device, can be optimized exactly to fit the users specific needs. For many func-
tions, the number of stages can be determined. Thus, the user can adapt the functions exactly to individual
protection concepts. Modification of the device Function Configuration selection will automatically be
reflected in the devices other user files and therefore should be modified first during configuration.

[sc_7SR5_ReydispManager2FunctionConfiguration, 1, --_--]

Figure 2-30 Reydisp Manager 2 Function Configuration

Function templates comprise Function Groups (FG) and within each FG there may be a number of Func-
tion Elements (FE).

Modifying the Device Application Function Configuration
The default configuration for the device contains a file for the user to customize the functions and elements in
the 7SR5 configuration. The default file contains all functions and elements available for the selected device
type. Only a subset of the available items are selected to be included in the default configuration.
 

Goal
The goal of this chapter is to create a functional configuration suitable for the users application in the offline
configuration.
 

Overview of the Procedure
Perform the following actions:

• Open the user Function Configuration.

• Modify the Voltage Input association with a Transformer Winding in the device offline configura-
tion.

• Include/Remove additional function elements in the device offline configuration.

• Modify the analogue inputs which the element is configured to use in the device offline configuration.
Opening the Function Configuration will generate the Device Configuration file from the Device
Application template.

[sc_7SR5_ReydispManager2PreparingDeviceConfiguration, 1, --_--]

Figure 2-31 Reydisp Manager 2 Preparing Device Configuration

2.5
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If the device hardware includes voltage inputs that can be associated with different CT configurations the VT
Mapping Option will be available for selection from a drop down menu. In the following example
VT1,VT2,VT3 are selected to operate with Transformer Winding 1 functions.

[sc_7SR5_ReydispManager2VTMappingOptions, 1, --_--]

Figure 2-32 Reydisp Manager 2 VT Mapping Options

The available functions in the template are shown under the function heading and can be expanded or hidden

using the  button.
Every element available in the function is listed and can be selected to be included in the device configuration
by ticking the included option box. The elements must be selected/deselected in numerical order.

[sc_7SR5_ReydispManager2SelectingFunctionElements, 1, --_--]

Figure 2-33 Reydisp Manager 2 Selecting Function Elements
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If the device has multiple analogue inputs that could be used with the element the user must select the
anlogue association. This is done by selecting the CT using the option button.
The following example shows the following association:

• 51-1 element is configured to use CT1, CT2, CT3

• 51-2 element is configured to use CT5, CT6, CT7

• 51-3 element is configured to use CT9, CT10, CT11

[sc_7SR5_ReydispManager2ElementConfigurationExample1, 1, --_--]

Figure 2-34 Reydisp Manager 2 Element Configuration

All elements can be selected to use the same analogue inputs or any combination.
The following example shows the following association:

• 51-1 element is configured to use CT5, CT6, CT7

• 51-2 element is configured to use CT9, CT10, CT11

• 51-3 element is configured to use CT9, CT10, CT11

[sc_7SR5_ReydispManager2ElementConfigurationExample2, 1, --_--]

Figure 2-35 Reydisp Manager 2 Element Configuration

Select the Apply button to confirm the configuration and generate the new device configuration.

[sc_7SR5_ReydispManager2NewDeviceConfiguration, 1, --_--]

Figure 2-36 Reydisp Manager 2 New Device Configuration
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Creating a Logic Diagram
Overview

Reylogic Express is a tool to create custom graphical logic diagrams for the device.
Multiple logic diagrams can be created and text labels can be added to annotate diagrams to effectively
organize more complex logic schemes.
Reylogic Express is launched by selecting the desired 7SR5 device and clicking Logic in the task pane.
These functions take care of, for example, the following tasks:

• Interlockings

• Formation of group indications

• Failure indications

• Interface between device signals and GGIO

• Interface between device signals and user signals for HMI screens
Reylogic Express consists of the following items, shown on the left side of the window:

• Logic
Provides standard logic such as AND, OR, XOR, NOT as well as user inputs/outputs, counters and latches.

• Logic Diagrams
A diagram holds the user logic. A scheme can be made up of multiple diagrams.

• Scheme Signals
Shows a list of user outputs available in the current logic scheme from all diagrams.

• Device Signals
Inputs and output signals specific to the selected device.

 

Logic Symbol Overview
A number of logic symbols can be used within Reylogic Express diagrams.

Table 2-1 Reydisp Manager 2 Logic Symbol Overview

Symbol Description
External input

Internal input

AND gate

XOR gate

Counter

NOT gate

External output

2.6
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Symbol Description
Internal output

OR gate

Set/Reset latch

Pickup/Dropoff timer

 

Logic Symbol Properties
The properties of logic symbols can be altered by way of the property grid. The property grid is located on the
right hand side of Reylogic Express.

[sc_7SR5_ReydispManager2PropertyGrid, 1, --_--]

Figure 2-37 Reydisp Manager 2 Property Grid

When a single symbol is selected that symbol's properties will be displayed in the property grid. This allows
you to edit property fields for the symbol.
 

External and Internal Symbols (Inputs/Outputs)
There are 2 types of input/output signal in Reylogic Express, External and Internal.
An external symbol is provided by the host device. External inputs are driven by the device and can be used as
inputs on your logic diagrams. External outputs are read by the device and are driven by your logic diagrams.
They can be used as outputs on your logic diagrams.
Each device has a list of signals which can be used as either inputs or outputs to your logic scheme.
All external signals available to a device are shown on the project tree under Device Signals. The device
signals are ordered into logical groups (type, function, protection elements, etc).
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[sc_7SR5_ReydispManager2DeviceSignalsProjectTree, 1, --_--]

Figure 2-38 Reydisp Manager 2 Device Signals Project Tree

All other signals in Reylogic Express are internal. These signals exist only in your logic scheme and are
not visible to the rest of the device.
In Figure 2-38 an external signal from the device function key is made visible to the logic scheme by the use of
external input Function Key 1. The signal is used to drive an internal signal My Internal Signal. The
internal signal is then used to drive the user output signal by use of an external output User Output 1.

[dw_7SR5_ReydispManager2UserLogicScheme, 1, en_US]

Figure 2-39 Reydisp Manager 2 User Logic Scheme

Essential Steps during Engineering
2.6 Creating a Logic Diagram

Reyrolle 7SR5, Engineering Guide, Manual 55
C53000-G7040-C013-1, Edition 04.2020



 

Logic Diagrams
Logic diagrams can be created, deleted, renamed and reordered.
To add a new diagram to the logic scheme the user can either:

• Use the menu File > New Diagram
• Use the toolbar icon

[sc_7SR5_ReydispManager2FileNew, 1, --_--]

Figure 2-40 Reydisp Manager 2 New Diagram Icon

• Use the keyboard shortcut CTRL + N
• Use the mouse to right-click on the Logic Diagrams section of the project tree. Select New Diagram

from the menu.

[sc_7SR5_ReydispManager2NewDiagramMenu, 1, --_--]

Figure 2-41 Reydisp Manager 2 Project Tree New Diagram
A new diagram will appear in the project tree under Logic Diagrams. Each new diagram will take a new
unique name (Diagram 1, Diagram 2, etc).
The new diagram page will also be displayed ready for symbols to be added.
Logic diagrams can be removed from the scheme by locating the diagram in the Logic Diagrams section of
the project tree. Right-click on the diagram to be deleted and in the menu that appears select Delete
Diagram.
Diagrams can also be reordered.
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[sc_7SR5_ReydispManager2ReorderDiagrams, 1, --_--]

Figure 2-42 Reydisp Manager 2 Diagram Reordering

Reylogic Express has quick view operations to zoom and pan to sections of your diagrams.

• Displaying the full Logic Diagram (Zoom Document)
Zoom and pan the active diagram so that the whole diagram page can be seen in the tab pane. There are
multiple ways to achieve this:
– In the menu click View then Zoom Document with the mouse.

– With the keyboard press CTRL + 9.

– Click the Zoom Document toolbar item with the mouse.

• Displaying all Logic (Zoom Diagram)
Zoom and pan the active diagram so that all visible logic on the diagram is within the view. There are
multiple ways to achieve this:
– In the menu click View then Zoom Diagram with the mouse.

– With the keyboard press CTRL + 8.

– Click the Zoom Diagram toolbar item with the mouse.

• Displaying all Selected Logic (Zoom Selection)
Zoom and pan the active diagram so that all selected logic on the diagram is within the view. There are
multiple ways to achieve this:
– In the menu click View then Zoom Selection with the mouse.

– With the keyboard press CTRL + 7.

– Click the Zoom Selection toolbar item with the mouse.

• Panning Logic Diagrams
Panning the diagram involved moving the view of the logic diagram to suit your display purposes. There
are multiple ways to achieve this:
– Use the horizontal and vertical scrollbars at the bottom and right side of the diagram.
– Right-click on the diagram and move the mouse. Release the mouse button to stop panning.
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• Zooming In
View the diagram larger. There are multiple ways to achieve this:
– In the menu click View then Zoom In with the mouse. This will zoom around the center of the

current view.
– With the keyboard press CTRL + +. This will zoom around the center of the current view.

– Click the Zoom In toolbar item with the mouse.

– Holding the CTRL key on the keyboard and scrolling the mouse wheel upward while the mouse is
over the diagram view. This will zoom around the mouse point.

• Zooming Out
View the diagram smaller. There are multiple ways to achieve this:
– In the menu click View then Zoom Out with the mouse. This will zoom around the center of the

current view.
– With the keyboard press CTRL + -. This will zoom around the center of the current view.

– Click the Zoom Out toolbar item with the mouse.

– Holding the CTRL key on the keyboard and scrolling the mouse wheel downward while the mouse is
over the diagram view. This will zoom around the mouse point.

• Resetting Zoom Level
Resets the zoom level of the diagram view. This puts the diagram to a normal display size. There are
multiple ways to achieve this:
– In the menu click View then Zoom Reset with the mouse.

– With the keyboard press CTRL + 0.

– Click the Reset Zoom toolbar item with the mouse.

Logic diagrams, when opened for viewing, are displayed in a tabbed interface. The tabbed interface cable is
separated into 2 tab panes. This allows the user to view 2 diagrams at the same time. To display a diagram in
the second tab pane it must first be visible in the tab pane. To do this the user must right-click on the tab they
want to display in the second pane. In the menu that appears select Swap Pane.

[sc_7SR5_ReydispManager2SwapPaneMenu, 1, --_--]

Figure 2-43 Reydisp Manager 2 Swap Pane

The selected tab will now be moved to the second tab pane. Each tab pane can handle multiple diagram tabs.
Any diagram can be swaped to either pane.
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[sc_7SR5_ReydispManager2TwoPanes, 1, --_--]

Figure 2-44 Reydisp Manager 2 Two Panes

Adding a New Logic Diagram
The default configuration for the device contains a file for the user to add a new logic diagram to the 7SR5
configuration files. The individual logic diagram will depend upon the users application requirements.
 

Goal
The goal of this chapter is to create a new logic diagram in the offline configuration.

[sc_7SR5_ReydispManager2DefaultDeviceConfiguration, 1, --_--]

Figure 2-45 Reydisp Manager 2 Default Device Configuration

 

Overview of the Procedure
Perform the following actions:
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• Open the User Logic graphical logic interface.

• Add a logic diagram to the logic file in the device offline configuration.

• Give the logic diagram a specific name.
 

Adding a new Logic diagram
In the file configuration view of the 7SR5 device, open the User Logic.
The Reylogic Express window will be launched.
Add a new diagram .

[sc_7SR5_ReydispManager2FileNew, 1, --_--]

Figure 2-46 Reydisp Manager 2 New Diagram Icon

A new diagram will be visible in the Tree, named Diagram 1. Select the diagram and rename.

Adding Logic Symbols and Interconnecting the Items
The new diagram does not contain any logic and an empty space is shown in the working area instead. This
chapter describes how to add symbols and device points to the diagram and make connections.
 

Overview of the Procedure
Perform the following actions:

• Add the required function logic symbols and device connection points.

• Interconnect the symbols and points.
 

Adding a Symbol or Device Data Signal to the Chart
Use the mouse to locate the required signal or symbol in the project tree.
Use the mouse to click and drag the required signal or symbol from the tree.
While dragging the signal move the mouse over the diagram to place it.
When happy with the placement of the signal release the mouse button.
The external signal will now be placed on the diagram.

ii NOTE
If the symbol has any properties these will be shown in the right hand side pane.
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[dw_7SR5_ReydispManager2AddingSignal, 1, en_US]

Figure 2-47 Reydisp Manager 2 Adding Signal

[dw_7SR5_ReydispManager2AddingSymbol, 1, en_US]

Figure 2-48 Reydisp Manager 2 Adding Symbol

 

Interconnecting Function Block with Signals
The connection to the necessary signals is established very simply.
Logic symbols provide a number of connection points which can be used to connect symbols together.
Connection points are displayed as protruding from the left/right of symbols. Connection points on the left
side of the symbol are that symbol's inputs. Connection points on the right side of the symbol are that
symbol's outputs.
A connection can be made between any output connection point and any input connection point which is not
already used.
To connect 2 symbols together:

• Move the mouse over a connection point (either connection point which will be used in the new connec-
tion).

• Click and hold down the left mouse button.

• Move the mouse across the diagram (toward the second connection point to be used in the new connec-
tion). As the mouse is moved a connection indicator will display reminding which connection point is
being dragged.

[sc_7SR5_ReydispManager2CreatingLogicConnections, 1, --_--]

Figure 2-49 Reydisp Manager 2 Connecting Symbols

Essential Steps during Engineering
2.6 Creating a Logic Diagram

Reyrolle 7SR5, Engineering Guide, Manual 61
C53000-G7040-C013-1, Edition 04.2020



• Move the mouse over the second connection point to be used in the connection.

• Release the left mouse button to create the connection.

[sc_7SR5_ReydispManager2CreatingLogicComplete, 1, --_--]

Figure 2-50 Reydisp Manager 2 Connected Symbols

ii NOTE
If the connection made is not valid (for example an attempt has been made to connect 2 output connection
points, 2 input connection points or an input connection point already connected to another symbol has
been used) then no connection will be made.

ii NOTE
Signals and symbols can be moved, copied and deleted. Please refer to the Reylogic Express user manual
for further information.

Logic Validation Scheme Warnings and Errors
When a graphical logic scheme is closed or saved the diagrams are validated. Reylogic Express may inform you
of cases where errors have occured in your logic scheme. It may also produce warnings to point out bad prac-
tices and scheme issues to be aware of.
Warnings and errors are listed in the notification area. Notification entries will specify the problem. If the
problem relates to a specific diagram the diagram name will be displayed. If the warning/error relates to a
specific symbol the symbol name will be displayed. If a warning or error relates to a specific symbol it is
possible to quickly navigate to that symbol by using the left mouse button to double-click on the warning/error
line of the notification area.

[sc_7SR5_ReydispManager2WarningsandErrors, 1, --_--]

Figure 2-51 Logic Validation Scheme Warnings and Errors
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Creating a User Display Page
Overview

The 7SR5 devices are designed with a large graphic display. The 7SR5 device is delivered with a single user
HMI configuration displaying the primary metered values applicable to the application option ordered by the
MLFB code. The device can be used without any additional user configuration. The display is a 16 by 16 grid
with grid lines for positioning the symbols and can be configured for up to 5 user HMI display screens with
static, dynamic or controllable graphics.
 

HMI Screens
Using the ReyMimic Editor, up to 5 different display pages can be configured for each 7SR5 device and loaded
into the device. In the device, to switch between the available display pages the right arrow key is used. The
display number is shown in the bottom right hand corner of the display. The display pages are ordered in the
PC tool with number 1 as the default home page. This default page is shown in the display when the device is
first switched on or restarted or if the cancel key is pressed repeatedly from the menus. Display pages are
always device-specific. The display pages for a 7SR5 device are thus part of the offline configuration of this
device.
HMI screens can be renamed after they are created by right-clicking on the file in the task window and
selecting the Rename HMI Screen.
 

Options
When a new display page is added to the offline configuration, this page does not yet contain any elements.
Instead, an empty space is shown in the working area of the ReyMimic Editor. In this area, drag and drop is
used to insert busbars, disconnectors, circuit‑breakers, and other equipment from the symbol library. Text can
be added to the graphical representation and connect dynamic graphic elements with process information. In
this way, it is possible to visualize the states of equipment items, for example, the position of a circuit‑breaker,
on the display page. In addition, the control output signals produced from the symbol can be linked when
used to control a state change from the display page. The device signal lists are automatically generated in the
configuration and in addition to the usual device signals a number of user mimic signals are provided to
manage interlocking logic.
 

Organizing the HMI Screens
The offline configuration allows the user display pages to be arranged in the preferred sequence to be viewed
in the device.
Right-click on the device in the tree view and select Organize HMI Screens. The screens can be moved up
and down the viewing order using the buttons and selecting Apply.
 

Symbol Positioning
All icons for display pages are provided in a standard symbol library which is visible in a tree structure in the
left hand pane. The main diagram page is marked with grid lines for positioning the symbols. If an element is
inserted from the library, the element symbol is shown as in the library but can be rotated and moved.

[sc_7SR5_ReydispManager2ElementSymbolRotateIcon, 1, --_--]

Figure 2-52 Reydisp Manager 2 Element Symbol Rotation Icon
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Display Editor
The ReyMimic Editor tool is used to generate the user screens for a 7SR5 device. The editor consists of a
working area and a toolbar for specific actions.

[sc_7SR5_ReydispManager2ReymimicDisplayEditor, 1, --_--]

Figure 2-53 Reydisp Manager 2 Reymimic Display Editor

Creating a New Display Page
A new display page does not yet contain any elements. An empty space is shown in the working area instead.
This chapter describes how to create a feeder on the display page using individual elements selected from the
library.
 

Goal
The goal of this chapter is to create the user screen shown in the following figure.
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[sc_7SR5_ReydispManager2ExampleUserMimicDisplay, 1, --_--]

Figure 2-54 Reydisp Manager 2 Example User Mimic Display

The display page contains one or more of each of the following elements:

• Busbar

• Circuit‑breaker

• Isolator

• Earth switch

• Meter text

• Static text

• Feeder
 

Overview of the Procedure
Perform the following actions:

• Add a new display page and rename it.

• Insert a busbar into the display page.

• Insert additional equipment into the display page.

• Connect the individual elements to the device signals.

• Insert the static text into the display page.
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Adding a New Display Page and Renaming It

[sc_7SR5_ReydispManager2NewDisplayPageandRename1, 1, --_--]

Figure 2-55 Reydisp Manager 2 Add HMI Screen

[sc_7SR5_ReydispManager2NewDisplayPageandRename2, 1, --_--]

Figure 2-56 Reydisp Manager 2 Blank HMI Screen
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[sc_7SR5_ReydispManager2NewDisplayPageandRename3, 1, --_--]

Figure 2-57 Reydisp Manager 2 HMI Screen Rename

Up to 5 user HMI display screens can be created for each 7SR5 device.

[sc_7SR5_ReydispManager2NewDisplayPageandRename4, 1, --_--]

Figure 2-58 Reydisp Manager 2 Finish New HMI Screen

In the tree structure of the offline configuration, right-click Add HMI Screen. The user can select to use a
library screen as a starting screen or a blank screen.
Select a name for the HMI page. On completion the new HMI file is added and shown in the working area.
Open the file by double‑clicking.
Click another area of the display page.
Drag and drop elements from the library tree onto the screen page.
Zoom in or out using the drop down menu located at the bottom of the window or holding the control key
and using the mouse scroll. Use the rotate symbols to adjust the symbol to the correct orientation.

ii NOTE
The HMI display file name can be edited at a later date.
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Inserting the Busbar
The Diagram Tiles folder contains common single line diagram symbols.
Select the Tee symbol and drag to the desired position on the page.
Release the mouse button. The busbar is placed at the selected position within the grid and can be moved or
rotated.

Adding Additional Equipment
Insert additional equipment from the library tree into the display page via drag and drop in the same way as
the busbar.
Highlight the element Circuit Breakers in the open position in the tree.
Hold down the right mouse button and drag the element into the working area, positioning it below the
busbar.
Release the mouse button. The circuit‑breaker is now placed at the insertion position.
Repeat this procedure for the elements, Isolator and Earth Switch. Position the elements as shown in
Figure 2-54.
Rotate the Earth Switch by 90° by highlighting the item and selecting the Rotate symbol in the menu.

[sc_7SR5_ReydispManager2ElementSymbolRotateIcon, 1, --_--]

Figure 2-59 Reydisp Manager 2 Element Symbol Rotation Icon

Complete the diagram by selecting suitable items from the Diagram Tiles folder. Some tiles will need to be
rotated.
The mimic display should now look like the following figure.

[sc_7SR5_ReydispManager2DisplayPagewithConnectedElements, 1, --_--]

Figure 2-60 Reydisp Manager 2 Display Page with Connected Elements
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Inserting Static Text into the Display Page
A display page can contain static text. Static text is information that you can add to the display page. Insert a
static textbox from the library tree into the display page via drag and drop in the same way as the busbar and
enter the text information into the Properties box on the right hand side of the display.
Expand the Text folder and select Static Text.
Hold down the right mouse button and drag the static text into the working area, positioning alongside the
circuit‑breaker.
Enter the required text into the properties.
Repeat for the Isolator and Earth Switch. The text entered is applied on the display page.
The goal has been achieved.

[sc_7SR5_ReydispManager2StaticText, 1, --_--]

Figure 2-61 Reydisp Manager 2 Static Text Added

Inserting Meter Text into the Display Page
A display page can contain meter text. Meter text is information that can be added to the display page to
display a dynamic value of measurement, instrumentation and information from the device. Insert a meter
textbox from the library tree into the display page via drag and drop in the same way as the static text and
select the information to be displayed from the device signal list in the Properties box on the right hand
side of the display.
Expand the Text folder and select Meter Text.
Hold down the right mouse button and drag the meter text into the working area, positioning in a free area of
the screen.
In the Properties area use the drop down to locate the information signal to be displayed, for example
Primary Ib.
Repeat to display the MLFB order code above the busbar tile. The text entered is applied on the display page.
The goal has been achieved.
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[sc_7SR5_ReydispManager2MeterText, 1, --_--]

Figure 2-62 Reydisp Manager 2 Meter Text Added

Adding Plant Control Signals to the Display Page
Signals can be added to the display page and in this way create a dynamic value display and a dynamic posi-
tion display.

• Active Text
With the dynamic Active Text display, device signals can be used to display specific user messages in
accordance with the state of the signal, for example, On or Off.
The Active Text element can be connected to be controllable from the fascia and send a command
signal out from the device.
Active text only has 2 states for control commands.

• Dynamic Position display and control
A graphical element can be connected having multiple states to a device signal. In this way, it is possible
to control the states of the graphical element on the display of the 7SR5 device in accordance with the
state of the signal.
For example, connect the graphical element for a circuit‑breaker to the position signal of the corre-
sponding circuit‑breaker. If the circuit‑breaker is closed, the display on the unit shows the closed
circuit‑breaker symbol. If the circuit‑breaker is open, the display on the unit shows the open
circuit‑breaker symbol. This also applies to the intermediate and disturbed position of the circuit‑breaker.
Connect the graphical element to be controllable from the fascia and send a command signal out from
the device.

 

Goal
The goal of this chapter is to enable the circuit‑breaker symbol to mimic the position of the circuit‑breaker and
control the circuit‑breaker from the device fascia mimic control. Then to add Active Text to display and
control a plant item without a symbol.
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[sc_7SR5_ReydispManager2DisplayPageAddedActiveTextDefault, 1, --_--]

Figure 2-63 Reydisp Manager 2 Display Page with Added Active Text in Default

The display page contains the following items for configuration:

• The plant elements will also have a properties area associated with them.

• The active text is added to the display page with a properties area to the right hand side.
 

Overview of the Procedure – CB Control
Perform the following actions:

• Select the circuit‑breaker symbol already placed on the diagram.

• Insert the alternative plant symbols in the right hand side properties area.

• Add the signals to drive the symbols.

• Enable output signals for control operation.

• Name the controllable device for description in device menus.

• Select the output type of Steady or Pulse operation of the control output signals.

• Add control output signals.
 

Opening the Signal Catalog and Selecting the Offline Configuration
With the mimic editor open, highlight the Circuit‑breaker symbol. The default symbol placed on the
diagram will be shown in the right hand area of properties, marked as default. The default symbol is the
symbol that will be displayed when the device starts up and if none of the input signals are driving an alterna-
tive symbol.
Select the + symbol to add alternative symbols for the circuit‑breaker or same device object. For this example
3 additional symbol objects will be added.
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[dw_7SR5_ReydispManager2AddAdditionalSymbolObjects, 1, en_US]

Figure 2-64 Reydisp Manager 2 Add Additional Symbol Objects

For each additional object View a symbol must be selected from the drop down menu. Alternatively a
symbol can be dragged from the symbol tree and dropped into the Symbol property.
If the symbol is not in the correct orientation this can be adjusted by highlighting the property line and using
the rotate buttons.
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[dw_7SR5_ReydispManager2SymbolRotation, 1, en_US]

Figure 2-65 Reydisp Manager 2 Symbol Rotation

The signal catalog is displayed.
The symbol order of priority can also be changed using the Up and Down arrows.
In the Input Name select the device signal from the drop down list which is to be used to drive the symbol
on the HMI screen.
The signals available from the selected offline configuration are created from the devices available signals for
configuration and MLFB application template and included functions. The signals are structured hierarchically
in different groups. Individual groups can be expanded and closed. To do so, simply click the arrows on the left
of the group names as in the library. The signals for the device circuit‑breaker can be found in the Functions
> Control > 52 menu
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[sc_7SR5_ReydispManager2Circuit-BreakerSignals, 1, --_--]

Figure 2-66 Reydisp Manager 2 Circuit-Breaker Signals

 

Adding a Signal for Connection to the User Logic Scheme
In the signal list, in addition to the standard device signal the user is provided with some additional signals to
allow an easy interface to the user logic.
These additional 10 operation signals are located in the sub menu General > User Mimic Symbols.
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[sc_7SR5_ReydispManager2UserMimicSymbols, 1, --_--]

Figure 2-67 Reydisp Manager 2 User Mimic Signals

ii NOTE
When configuring Controllable Plant items the user must ensure that for safety reasons all inter-
locking logic is created in the user logic area. Siemens are not responsible for the design, implementation
and testing of Interlocking logic.

 

Connecting an Output Command Signal from the Operation of a Display Item
Under the symbol properties area for the chosen item the Enable Output Signals can be selected to
allow the item to be a Controllable Item. This will enable the option to create output signals when the
item state is changed in the fascia control. Multiple Items can be configured to be Controllable.
Enter a suitable name for the Controllable Item.
When the item changes state from the control menu, select whether the output signal should be a pulse signal
or a steady state operation. Siemens recommends that plant is controlled using a pulsed output. A steady state
output will generate a signal whenever the item is in a particular condition/position. All graphical elements do
not have to be controllable items.
The item will now show a different symbol to represent the input conditions driving the state and will allow
the user to control the item and produce the necessary output signals.
The screen should now look as follows.
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[sc_7SR5_ReydispManager2MimicControlledItem, 1, --_--]

Figure 2-68 Reydisp Manager 2 Mimic Controlled Item

The goal has been achieved and if finished, the Mimic Editor can be closed and the file saved.
 

Overview of the Procedure – Active Text
Perform the following actions in the sample procedure as for the mimic items:

• Insert Active Text onto the diagram in the desired location using the drag and drop method.

• Insert the Text Labels that should be displayed along with the signals to drive the text.

• Enable output signals for control operation if required.

• Name the controllable device for description in device menus.

• Select the output type of Steady or Pulse operation of the control output signals.

• Add control output signal from the control operation in the Output A.

What is Output A – definition required.
All Active Text does not have to be controllable.
The screen should now look as follows.
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[sc_7SR5_ReydispManager2ActiveText, 1, --_--]

Figure 2-69 Reydisp Manager 2 Mimic Controlled Item with Active Text

The goal has been achieved and if finished, the Mimic Editor can be closed and the file saved.
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Creating User Curves
Overview

The device configuration supports the ability to add custom (User defined) curves to the device. User defined
curves are created and added to the device configuration. Once added they will appear as a selectable setting
option in the Char parameter list, using the name that is entered when the curve is created, for all elements
which are applicable. Both operate and reset curves can be created as required.
The 7SR5 relay will support a maximum of 5 user curves in a device configuration.
The Curve Editor tool allows user-definable curves to be created.
To assist in the creation of the user curves, reference curves can be viewed and compared in the tool.
For a more detailed guide on using Curve Editor, refer to the Reyrolle Curve Editor User
Manual. The user manual for the Curve Editor can be accessed by opening the Curve Editor main
window and clicking Help > User Guide.

Scope

Curve Files
The following curve types are supported. The curve types available depend on the device template.
Curve Type Curve Extension Description

• Current Curve .I_CRV Current curve, for use with IDMTL current elements.

• Voltage Curve .V_CRV Voltage curve, for use with IDMTL voltage elements.

• Thermal Curve .THERM_CRV Thermal curve, for use with thermal elements.

ii NOTE
Curve files can be created and then sent to the device on site. However, the device settings must be
changed in the Setting Editor to set the element to use the user curve characteristic.

2.8
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[dw_7SR5_ReydispManager2SettingEditorOverview, 1, en_US]

Figure 2-70 Reydisp Manager 2 Setting Editor Overview

(1) Graph pane
(2) Current mouse coordinates
(3) Operate curve points
(4) Reset curve points
(5) Curve parameters
(6) To add a point, enter x and y values (x is x Multiple of Setting, y is Time (s)) then click

Add Operate Point

Overview of the Procedure
Perform the following actions:

• Add a curve to the device configuration from the device in the tree view.

• Enter a name for the curve.

• Select the type of curve – Current, Voltage or Thermal.

• Create a curve from a user defined file, template or equation.

Curve Editor
To add a user curve and subsequently launch the Curve Editor, click on the device in the menu tree and
right‑click.
Select the Add Curve.
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[sc_7SR5_ReydispManager2AddCurve, 1, --_--]

Figure 2-71 Reydisp Manager 2 Add Curve

In the Create Curve, give the curve a name. The name given here is the name that will be displayed on the
device. Names must be a maximum of 20 characters, consisting of the characters A-Z, a-z, 0-9 and space. The
curve cannot be given the same name as an existing curve used on this device.

[sc_7SR5_ReydispManager2CreateCurve, 1, --_--]

Figure 2-72 Reydisp Manager 2 Create Curve

Click Create to accept.
This brings up the Reyrolle Curve Editor main window, as shown in Figure 2-70.
For this example, an existing template will be used rather than applying any grading or manually entering
points or equations.
Select File > Create Curve From.
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[sc_7SR5_ReydispManager2CreateCurveFrom, 1, --_--]

Figure 2-73 Reydisp Manager 2 Create Curve From Window

Select the Template option and select a suitable curve from the dropdown list.
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[sc_7SR5_ReydispManager2CreateCurveFromDropdown, 1, --_--]

Figure 2-74 Reydisp Manager 2 Create Curve From Dropdown List

A curve will appear in the window, once selected press OK.
The curve is loaded and the operate curve points displayed.
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[sc_7SR5_ReydispManager2OperateCurvePoints, 1, --_--]

Figure 2-75 Reydisp Manager 2 Operate Curve Points

The points can be edited and the curve can be configured if required. Please refer to the Reyrolle Curve
Editor User Manual in the Curve Editor tool for further guidance on advanced configurations.
Click X to close the window and Yes to confirm when prompted to save.

[sc_7SR5_ReydispManager2SaveCurve, 1, --_--]

Figure 2-76 Reydisp Manager 2 Save Curve

The curve Test is now visible in the list of configuration files for this device.
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[sc_7SR5_ReydispManager2CurveTest, 1, --_--]

Figure 2-77 Reydisp Manager 2 Curve Test

Select the curve in the Setting Editor.
The curve can be selected in the IDMTL settings. Click User Settings to open the Setting Editor.
For this example, a current curve is used, so 50 Phase Overcurrent element Char setting is shown.

[sc_7SR5_ReydispManager2CharSetting, 1, --_--]

Figure 2-78 Reydisp Manager 2 Char Setting
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File Management
The curve can be saved on the PC using the Save As feature for use in another device. The user defined file
selection should be used when creating the file in the device. Browse to the saved file and use the pre config-
ured curve.
Right‑click on the curve file will also give the option to:

• Open the curve for editing

• Delete the file from the device

• Copy the file for use in a different device within the project.

• Rename the curve
To paste a curve into the device, a right‑click on the device or in the configuration working area will allow a
Paste option.

[sc_7SR5_ReydispManager2PasteCurve, 1, --_--]

Figure 2-79 Reydisp Manager 2 Paste Curve
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Parameterizing Functions
Overview

The parameters for all protection functions are preset to default values. These values can be adapted to the
real circumstances and requirements. Function groups and function elements that have been included can be
Enabled or Disabled using Reydisp or from the device fascia:

• Protection and automation function elements

• Supervision function elements

• Control function elements
From the device fascia the protection, supervision and control function groups are enabled and disabled in the
Settings > Functions > Function Config menu.
Function element parameter changes can be entered from the device fascia or from Reydisp Manager. These
can be for the Function Groups (FG) or Function Elements (FE) i.e. the Settings > Function
menus. Function groups and elements can be added or removed only by using the Reydisp software configu-
rator tool.
In addition to the protection functions, the Settings folder contains other functions and parameters, for
example, for input/output mapping or fault recording in the Setting > Configuration.
 

Scope
All protection functions whose parameters and values are part of the offline configuration of a 7SR5 device
and are contained in the Settings folder. The protection functions are sorted by function groups.

[sc_7SR5_ReydispManager2UserSettingsFile, 1, --_--]

Figure 2-80 Reydisp Manager 2 Project Tree showing User Settings File

ii NOTE
Some parameter setting changes from the fascia will cause the device to restart.

 
Settings Groups
Different operating cases can require different function settings. To save and use the protection function
settings for different operating cases, use settings groups. In a settings group, the parameters can be set
specifically for an operating case.
7SR5 devices support 4 independent settings groups and are provided for each function -Group number (Gn) 1
to 4.

2.9
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[lo_7SR5_FunctionConfigurationlogicdiagram, 1, en_US]

Figure 2-81 Reydisp Manager 2 Function Configuration Logic Diagram

 
Settings Editing
With the Settings Editor, the settings of parameters are processed, for example, of protection functions
or of the data storage. The parameter settings are represented in one of the following ways:

• Drop down menu selection (pc tool)

• Scroll menu selection (fascia)

• Bit String (fascia)

• Text entry

• Matrix view (pc tool)

Selecting the Appropriate Mode for Fascia Setting
From the fascia you can enter and display parameter values as primary values, secondary values, or as default.
They are shown as xNom. The decision concerning the mode depends on user preference.

• Multiple of Nominal Current (xNom)

• Primary values

• Secondary values
In Reydisp Manager the parameters are set using xNom (xIn or ⋅ Irated).

Parameter Setting from Fascia
Parameters can be divided into 3 different categories:

• Text parameter
Text parameters can accept defined characters.

• Scroll parameter
Scroll parameters are predefined selections of values or operations, for example 0.20 or Enabled.

• Bit String
Parameters are defined by selecting a 1 in a bit location. The selections are made in 8 position selections.
In the following example BI4 is set to 50SOFT.
50SOFT _ _ _ 1 _ _ _ _ BI 4

Using the fascia keys navigate to the required parameter.
When the required parameter is located press the Enter key to allow editing of the setting.
When editing a parameter from the fascia the Setting ID will be required if active.
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Table 2-2 Fascia Pushbuttons

Menu navigation and settings increase

Menu navigation and settings decrease

Enter key, used to initiate and accept settings changes

Cancel key, used to cancel settings changes and/or move up the menu structure
by one level per press

Menu navigation. Binary output reset from home screen (3 second delay)

 

Overview of the Procedure
Perform the following actions:

• From the fascia navigate to the Setting menu.

• Change the values of the parameters.
 

Editing a Parameter from the Fascia
From the Home HMI screen use the Down Arrow to enter the Main Menu screen.
The Settings Option should be highlighted. If not, use the Up/Down keys to navigate to it. Press the
Right Arrow to enter the Settings menu.

ii NOTE
Siemens recommend only the Functions parameters are adjusted from the fascia as many parameters in
the Configuration menu may require a device restart when changed.

The display now shows the sub menus Configuration and Functions. Names of all available function
groups are listed.

[sc_7SR5_ReydispManager2ViewEditGroup, 1, --_--]

Figure 2-82 Reydisp Manager 2 View/Edit Group
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ii NOTE
The Active Setting group and View/Edit group are displayed on the top of the HMI. Please ensure
you are viewing/editing the correct group before proceeding. The View/Edit group can be changed from
the Configuration > Device menu on the fascia. If the setting is not group dependent and common
to all groups the View/Edit information is not applicable and therefore not seen.

Use the Down Arrow to highlight the Function menu and the Right Arrow to enter the menu.
Navigate using the Down Arrow and Right Arrow to the desired parameter.
Press the Enter key to edit the parameter setting. If a Setting ID is active the user must enter this before
editing a setting. The lock symbol in the top right hand corner will indicate if the settings are locked and ID is
required.
The HMI will display the parameter name with the New Value flashing and the current/existing value
displayed below. Use the Up/Down or a combination of Right Arrow and Up/Down keys to adjust the setting.
When the desired setting is visible press the Enter key to confirm. The new parameter setting will now be
active in the device.

[sc_7SR5_ReydispManager2NewValue, 1, --_--]

Figure 2-83 Reydisp Manager 2 New Parameter Setting

ii NOTE
At any time if the X key is pressed it will cancel the operation or move one level up the menu tree structure.

A scroll bar on the right hand side of the display indicates the users position within the menu.

ii NOTE
If the setting dependencies are enabled, only the parameters of enabled functions will be visible for
viewing and editing on the HMI screen.

Parameter Setting from PC Tool
Parameters can be divided into 5 different categories:

• Text parameter
Text parameters can take accept defined characters.
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• Drop down parameter selection
Parameters are predefined selections of values or operations in a drop down list, for example 0.20 or
Enabled.

– Matrix
Parameters are defined in a matrix with the function listed down the left hand side, the parameter
across the top and the mapping selection in a grid matrix.

– Bit String Selection
Parameters where multiple value selections can be made.

– Set Value
Parameter where the value is entered by typing a value between a specific range, for example CT
Ratio Secondary.

 

Overview of the Procedure
Perform the following actions:

• From Reydisp Manager open the Setting Editor tool.

• Change the values of the parameters.
 

Opening a Setting File in the Settings Editor
From the device menu select the user setting file with device parameters. Double click to open.

[sc_7SR5_ReydispManager2UserSettingsDeviceParameters, 1, --_--]

Figure 2-84 Reydisp Manager 2 User Settings with Device Parameters

The Setting Editor will open with the setting tree visible.

ii NOTE
The setting tree in the PC tool is in the same format as on the device fascia.
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[sc_7SR5_ReydispManager2SettingEditor, 1, --_--]

Figure 2-85 Reydisp Manager 2 Setting Editor

The display now shows 2 tabs, one for Configuration and one for Functions with their sub folders in the
setting tree and any parameters and setting value in the right hand pane.
If a parameter setting is common to the device it will not have a setting group associated with it and will be
shown with no group, as shown in the following figure.

[sc_7SR5_ReydispManager2CommonSetting, 1, --_--]

Figure 2-86 Reydisp Manager 2 Common Setting
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If a parameter setting is specific to a group the display will have a tab for viewing each group and also a tab to
view all group values together.
The scroll bar on the right hand side of the window provides navigation to the entire menu list.

[sc_7SR5_ReydispManager2SpecificSetting, 1, --_--]

Figure 2-87 Reydisp Manager 2 Specific Setting

The matrix view allows the display to be filtered to reduce the number of signals in the display. The mapping
filters give the user the option to show all signals or only to show the mapped signals.
Additional filters are also provided in the matrix view to filter the input or output type, to show or hide signals
when they are mapped, and to simplify the view.
The user can choose to view all parameter settings for a particular element or function by using the Filter
by option. In the following example the filter has been applied to the Output Matrix for all parameters
containing 37.

[sc_7SR5_ReydispManager2OutputMatrixFilter, 1, --_--]

Figure 2-88 Reydisp Manager 2 Output Matrix Filter
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Changing a Parameter Setting
Click the Settings tab to make it active.
Click the folder in the tree to locate the required parameter.
Click the setting name the activate the setting value. The method for changing the setting will vary upon the
different setting type.
Drop Down Parameter
Select the value to expand and view the value options in the drop down menu.
In the device configuration tab the Binary Inputs > Input Matrix have both a list view tab and matrix
view.
The parameters shown in the matrix view are a duplication of the setting in the setting tree view and a change
made in either view will be automatically reflected in the other view.

[sc_7SR5_ReydispManager2InputMatrix, 1, --_--]

Figure 2-89 Reydisp Manager 2 Input Matrix View

[sc_7SR5_ReydispManager2InputMatrixVirtualsView, 1, --_--]

Figure 2-90 Reydisp Manager 2 Virtuals View
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[sc_7SR5_ReydispManager2SettingsDropDownMenu, 1, --_--]

Figure 2-91 Reydisp Manager 2 Settings Drop Down Menu

Select the desired value to appear as the setting value.
Text parameter
For a text setting, for example, Relay Identifier or User Alarm the text editor will be displayed. Type
the text required then press Enter.

[sc_7SR5_ReydispManager2TextSetting, 1, --_--]

Figure 2-92 Reydisp Manager 2 Text Setting

ii NOTE
Only valid characters will be accepted and a red ! warning symbol will be shown if an invalid character is
entered.

The HMI will display the parameter name with the new value flashing and the current/existing value displayed
below. Use the up/down or a combination of right arrow and up/down keys to adjust the setting.
When the desired setting is visible press the Enter key to confirm. The new parameter setting will now be
active in the device.
Set Value parameter
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For a set value setting, for example, CT Ratio Secondary value, a symbol with 3 dots will be shown along-
side the value.

[sc_7SR5_ReydispManager23DotIcon, 1, --_--]

Figure 2-93 Reydisp Manager 2 Icon with 3 Dots

Click on the box to open a window displaying the current value with the value range display to the right hand
side.
Enter the chosen value into the edit box and click Confirm. If a value or character outside of the predefined
range is entered an error message will be displayed.

[sc_7SR5_ReydispManager2SetValueDialog, 1, --_--]

Figure 2-94 Reydisp Manager 2 Set Value Dialog

Bit String Selection
For bit selection, the setting appears as a drop down menu. Opening the drop down menu lists the bit-wise
selection where multiple values can be selected.

[sc_7SR5_ReydispManager2BitSelection, 1, --_--]

Figure 2-95 Reydisp Manager 2 Bit Selection

Matrix Editor
To use the matrix editor click the appropriate tab to make it active. A subset of settings is listed in the left pane
and the controlled object across in rows. Click on the line/row to be edited to activate it, the row will be high-
lighted. Click the object to make the selection and the selection will be marked. The following screenshot
shows part of a matrix. In it LED (L) 4 will operate by Phase A Trip, L5 by Phase B Trip and L6 by Phase C Trip.
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[sc_7SR5_ReydispManager2MatrixEditor, 1, --_--]

Figure 2-96 Reydisp Manager 2 Matrix Editor

ii NOTE
If the setting dependencies are Enabled, only the parameters of enabled functions will be visible for
viewing and editing on the HMI screen.
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Configuring Communication
Overview

The device provides 1 front USB communication interface (Com2) on the fascia and 1 RS485 (Com1) on the
rear along with 2 Ethernet ports on the rear. The Ethernet ports can be ordered for connection with Electrical
RJ45 or Optical LC access. The access to the communication settings for the USB port is available from the
front menu structure via the keypad setting menu Communications or through the parameter configuration
PC software.
Communication interface

• Com2-USB
The Com2-USB port is used for configuring the device with Reydisp software and allows the updating of
firmware. The Com2-USB port has the IP address 192.168.2.1.

• Com1-RS485 (Terminal Reference X1)
The Com1-RS485 port can be used for DNP3.0, IEC 60870-5-103 or Modbus RTU communications to a
substation SCADA, integrated control system, or engineer remote access.
The port can be independently mapped to the DNP3.0, IEC 60870-5-103 or Modbus RTU protocol or
switched off in the device configuration.

• Com-Ethernet
2 electrical (RJ45) ports (Channel 1/Terminal Reference X2 and Channel 2/Terminal Reference X3) or 2
optical (LC) ethernet ports (Channel 1/Terminal Reference X4 and Channel 2/Terminal Reference X5).
The Ethernet ports can be used for IEC 61850 communications to a substation SCADA, integrated control
system, or engineer remote access using Reydisp configuration software.

The goal of this chapter is to select and configure the following connections and adaption of protocols:

• Configure RS485 port

• Adapt Fascia Event Log
• Protocol DNP3

• Protocol MODBUS RTU

• Protocol IEC 60870-5-103
The device configuration communication mapping can be printed using the Export Report function by
right clicking on the Serial Comms & Events file.

[sc_7SR5_ReydispManager2ExportReportMenu, 1, --_--]

Figure 2-97 Reydisp Manager 2 Export Report

Selecting and Configuring Serial Protocols on RS485
With a 7SR5 device, a rear RS485 (Com1) communication module is always provided for connection with a
serial communication protocol. The port has a number of parameters that must be set and in addition Reydisp
Manager – Serial Comms and Events is used to configure the communication protocol.
 

Overview of the Procedure
Perform the following actions:

2.10
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• Open the Device view and select the Device Parameters.

• Configure comm1 in the Configuration > Communications menu and save.

• Configure the 2 Ethernet interfaces for DNP3.
Parameter: COM1-RS485 Protocol
• Select the protocol used on the Com 1-RS485 interface port designated X1 on the rear of the device as

required.
Parameter: COM1-RS485 Station Address
• Select a unique address number to identify the device within the relevant range of the selected protocol.
Parameter: COM1-RS485 Baud Rate
• Select the baud rate. This is the rate at which the data is transferred via the RS485 serial for connection.
Parameter: COM1-RS485 Parity
• Select if a parity bit is added to the binary string to ensure the total number of bits is even or odd and is

used for error detection.
Parameter: COM1-RS485 Mode
• Select the operating mode of the RS485 port and is used in conjunction with the device operating mode.

Some actions are restricted on the port depending upon the ports mode and device operating mode.
If DNP3.0 protocol is to be used some additional parameters are provided.
Parameter: DNP3 Unsolicited Events
• Select if the DNP3 protocol should support unsolicited events in the users application.
Parameter: DNP3 Destination Address
• Default Setting: 0

If unsolicited events are to be sent a destination address for the master must be set.
Parameter: DNP3 Application Timeout
• Default Setting: 10

Configure the response time in seconds of the DNP3 application layer confirmation.
 

Settings Menu

Configuration > Data Storage
Parameter Range Default Setting
COM1-RS485 Protocol ASCII, IEC 60870-5-103, MODBUS-

RTU, DNP3, Off
Off

COM1-RS485 Station address 0 to 254 for IEC 60870-5-103
1 to 247 for Modbus RTU
0 to 65534 for DNP3

0

COM1-RS485 Baud rate 75, 110, 150, 300, 600, 1200,
2400, 4800, 9600, 19200, 38400,
57600, 115200, 230400

19200

COM1-RS485 Parity NONE, ODD, EVEN EVEN
COM1-RS485 Mode Local, Remote, Local or Remote Remote
USB Mode Local, Remote, Local or Remote Local
Ethernet Mode Local, Remote, Local or Remote Remote
DNP3 Unsolicited events Disabled, Enabled Disabled
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Configuration > Data Storage
Parameter Range Default Setting
DNP3 Destination address 0 to 65534 0
DNP3 Application timeout 5 to 300 s 10 s

Configuring the Fascia Event Log

Overview of the Procedure
Perform the following actions:

• Display communication mapping in the Comms Editor.

• Adapt required data

• Save as part of device configuration
 
Displaying Communication Mapping
In the project tree, open the folder for the offline configuration of a 7SR5 device.
In this folder, double-click Serial Comms & Events.
Right-click and select Configure Events option.

Adapting Communication Mapping for the Serial Protocol
To simplify project engineering, the device is provided with default communication mapping for the DNP3
protocol. As a consequence, routings for signals and settings are defined automatically for mapping parame-
ters. These routings can be adapted for specific requirements. Communication mappings are oriented to the
specific device model and configuration. For this reason, the communication mapping in the project structure
is always saved in the offline configuration of a device.
The communication mapping of a device can be edited using the Serial Comms & Events feature. A
comprehensive user guide is provided within the software tool for further support.
 

Overview of the Procedure
Perform the following actions:

• Display communication mapping in the Comms Editor.

• Adapt required data

• Save as part of device configuration
 
Displaying Communication Mapping
In the project tree, open the folder for the offline configuration of a 7SR5 device.
In this folder, double-click Serial Comms & Events.
The Comms Editor tool opens and displays the communication mapping of the device.
From the tabs on the right hand side of the window select the protocol that requires adaption.
Within the protocols the signals are shown according to data type with a page tab along the top.
The protocol and data type will determine the configurable options which can be edited and the options for
alternative selections.
Any protocols not available in the device template will be greyed out.
The following image shows DNP3 and data type binary output selected.

Essential Steps during Engineering
2.10 Configuring Communication

Reyrolle 7SR5, Engineering Guide, Manual 99
C53000-G7040-C013-1, Edition 04.2020



[sc_7SR5_ReydispManager2DNP3BinaryOutput, 1, --_--]

Figure 2-98 Reydisp Manager 2 DNP3 with Binary Output Selected

The adaption of the data point properties is done according to type enable/disable with a tick selection.

[sc_7SR5_ReydispManager2DataPointPropertiesTick, 1, --_--]

Figure 2-99 Reydisp Manager 2 Data Point Properties

Then entering a valid value.

[sc_7SR5_ReydispManager2DNP3ValidValue, 1, --_--]

Figure 2-100 Reydisp Manager 2 Enter Valid Value

Selecting from the provided drop down list.
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[sc_7SR5_ReydispManager2DNP3DropdownList, 1, --_--]

Figure 2-101 Reydisp Manager 2 Value Selection from Dropdown List

 
Context Menus
Context menus are provided when the user right-clicks on an editor page. A context menu is provided for each
protocol. When using the context menus all items selected in the list will be set to the chosen value if appli-
cable. Multiple items are selected using the standard selection method of clicking the mouse while holding
down the Shift or Control keys. This provides a quick method of setting multiple points to the same value.

[sc_7SR5_ReydispManager2ContextMenu, 1, --_--]

Figure 2-102 Reydisp Manager 2 Context Menu

In addition to the standard adaptions some protocols may have advanced settings that may be configurable.
These can be found by going to the Edit > Advanced Settings option as shown in the following figure.
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[sc_7SR5_ReydispManager2AdvancedSettingsMenu, 1, --_--]

Figure 2-103 Reydisp Manager 2 Advanced Settings

The advance setting configuration parameters will appear for editing.

Essential Steps during Engineering
2.10 Configuring Communication

102 Reyrolle 7SR5, Engineering Guide, Manual
C53000-G7040-C013-1, Edition 04.2020



[sc_7SR5_ReydispManager2AdvancedConfiguration, 1, --_--]

Figure 2-104 Reydisp Manager 2 Advanced Configuration for Communication Protocol DNP3.0
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Device Configuration of Ethernet
Overview

The Ethernet interface is used to configure the IEC 61850 interface. The Ethernet communication interface is
available in both electrical and optical versions. Both types are provided with an integrated switch function-
ality. This makes it possible to integrate the devices into common network structures together with third-party
components.

IP Address Tab
This tab allows the IP address of the device to be configured. The IP address, subnet mask and gateway
address all need to be set for the device to communicate on the network. These values will vary depending on
the network. The values shown here are an example only.
If a device is assigned to a station, then the device IP address is set by the station and the ability to configure it
from the IP Address tab is disabled to avoid conflicting IP addresses.

[sc_7SR5_ReydispManager2IPAddressTab, 1, --_--]

Figure 2-105 Reydisp Manager 2 IP Address Tab

Services Tab
This tab has no user configuration.

2.11
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SNMP (Simple Network Management Protocol): SNMP is enabled.
The MIB files for browsing to the device are available from the web site.

Redundancy Tab

[sc_7SR5_ReydispManager2RedundancyTab, 1, --_--]

Figure 2-106 Reydisp Manager 2 Redundancy Tab

Interface Type: By default, all IEC 61850 Reyrolle devices are set to use IEC 61850 Electrical
RJ45. If a fibre optic interface is present, this should be changed to IEC 61850 Fibre. To do this, select
IEC 61850 Fibre from the Interface Type drop down menu.
Operating Mode: The modules have 2 interfaces which are designed for either electrical or optical inter-
facing. The interfaces on the devices can be used in different operating modes. Select between Line mode or
Switch mode. The default is Line mode. (All further options are only enabled if the operating mode is set to
Switch). When set to Line mode, if the active link, i.e. the link transmitting data between the device and the
external switch, is broken, the interruption is detected and signaled by the link mentioned previously. When
an interruption is detected, switch to the second channel is performed immediately so that data exchange can
continue almost without interruption. The interruption signal is then transmitted via the standby channel.
Redundancy Type: When the Operating Mode is set to Switch, redundancy options are available to
select. This can show RSTP, OSM, PRP, and HSR depending on the interface type.
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• PRP-Structure
The PRP structure (Parallel Redundancy Protocol according to IEC 62439-3:2012) provides communica-
tion over 2 independent networks (LAN A and LAN B) simultaneously. Both networks may under no
circumstances be connected to one another. Siemens recommends building both networks identically.
Connect LAN A with channel 1 and LAN B with channel 2. In case of an interrupted network communica-
tion the device switches seamlessly.

• Operating Mode RSTP
RSTP stands for Rapid Spanning Tree Protocol. This is a standard network redundancy protocol. When this
option is selected, the advanced options are enabled. In this all operating devices are arranged in a ring.
One or more external switches must be integrated into this ring for the output of data, e.g. for display or
for transmission into a different network.
If the ring which includes the devices and the switch is broken, the ring becomes a line, and the function-
ality is maintained almost without interruption. If the ring is broken in a second place, the structure
cannot handle the resulting double error any more, and one part of the line will be disconnected. This
means that only single errors resulting from a broken ring can be handled.

• HSR Structure
The devices are arranged in rings in the HSR structure (High-availability Seamless Redundancy according
to IEC 62439-3:2012) . The procedure does not have parameters of its own. A seamless switchover will
take place if an interruption in communication occurs in a network. All components in HSR rings must
support HSR. If not connecting to HSR-enabled devices, use special switches that support HSR.

• OSM
OSM is a Siemens legacy redundancy protocol. It is only available for optical EN100 modules.

SNTP Tab
The Simple Network Time Protocol tab is completed when SNTP timer servers are required for a project where
the devices are not associated with an IEC 61850 station and the time server properties must be added
manually in the configuration. If the devices are part of an IEC 61850 station the option is greyed out in the
device configuration as the SNTP server is part of the system configuration.
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[sc_7SR5_ReydispManager2SNTPTab, 1, --_--]

Figure 2-107 Reydisp Manager 2 SNTP Tab
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Device Configuration of Ethernet Timezone
Overview

The device operational time is set in local time. The Ethernet Timezone feature allows the timezone to be
set for the device Ethernet port and allows the daylight saving times to be set. This is only applicable for
Ethernet communication.
By default, the relay is set to GMT, with no daylight saving offset specified

Configuring the Ethernet Timezone
To set the Ethernet timezone in the device configuration the user must select the following icon.

[sc_7SR5_ReydispManager2EthernetTimezoneIcon, 1, --_--]

Figure 2-108 Reydisp Manager 2 Ethernet Timezone Icon

The Edit Timezone dialogue window will appear for editing as required by the system application.

[sc_7SR5_ReydispManager2EditTimeZone, 1, --_--]

Figure 2-109 Reydisp Manager 2 Edit Timezone Properties

Time zone offset to UTC This should be set to the offset to UTC.
No summer time switchover Selecting this results in the time remaining the same throughout the year. If this

is ticked, the options below it relating to summer time are disabled.
Summer time offset to GMT This should be set to the offset to GMT for summer time.
Start of Summer Time The time daylight savings start.
End of Summer Time The time daylight savings ends.

2.12
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Clicking Apply will apply the new timezone to the device in the project.
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Adding an IEC 61850 Station
Overview

A station is an item that allows multiple IEC 61850 capable devices to be grouped together. Devices in the
same station can then be configured to communicate with each other.

Creating a New Station
To create a new station select the project folder and right-click to select the Create new 61850 station.

[sc_7SR5_ReydispManager2NewStation, 1, --_--]

Figure 2-110 Reydisp Manager 2 Create New Station

A new station is created and added to the project. By default, it is called “New Station” and will be listed in the
project tree.

[sc_7SR5_ReydispManager2NewStationProjectTree, 1, --_--]

Figure 2-111 Reydisp Manager 2 New Station in Project Tree

The station can be given a unique name by right-clicking on the station and selecting to rename. Enter a name
into the dialog box and select Apply.

2.13
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[sc_7SR5_ReydispManager2StationRename, 1, --_--]

Figure 2-112 Reydisp Manager 2 Station Rename

This new station has no devices assigned to it. The next step is assigning devices to it. Select the station in the
project tree and the working area of the display will show the Station Configuration icon and if the
additional Digsi system configurator tool is installed, as shown in the below example, the System Configu-
rator icon will also be visible.

[sc_7SR5_ReydispManager2StationSelected, 1, --_--]

Figure 2-113 Reydisp Manager 2 Station Selected

Devices are assigned to the station by selecting the Station Configuration icon, where a window will
display both the devices that are not associated with this station and those already associated.
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[sc_7SR5_ReydispManager2AssigningDevicestoStation, 1, --_--]

Figure 2-114 Reydisp Manager 2 Assigning Devices

All unassigned devices in the project are shown in the Unassigned Devices list. Select any devices to add
to the station and click Add. The devices are added to the Assigned Devices list and will be added to the
station.
The following restrictions apply when adding devices to a station:

• Each device can only be assigned to a single station.

• Each device assigned to the station must have a unique IED name.

• Device assignment cannot be changed if the System Configurator is open for the station.

To remove a device from the station, select the required device and click the Remove button. The device will
be removed and shown in the Unassigned Devices list.
The following restrictions apply when removing devices from a station:

• Device assignment cannot be changed if the System Configurator is open for the station.
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Loading Configuration into the Device
Overview

If the offline configuration of a device has been completely edited, the user can transmit this to the physical
device. To do this, the Reydisp Manager 2 PC and the 7SR5 device must be physically connected via a commu-
nication line to the front USB port for the first configuration.
 

Connection Facilities
There are 2 ways to connect the Reydisp Manager 2 PC to a 7SR5 device:

• Via USB

• Via rear Ethernet port using IP address

[sc_7SR5_ReydispManager2ConnectionOptions, 1, --_--]

Figure 3-1 Reydisp Manager 2 Connection Options

 

Confirmation IDs and Connection Password
Confirmation IDs are used for protection against unintentional and unauthorized operation from the fascia
and will not be required for a configuration change. If a connection or maintenance password is activated, it
must be entered before the relevant action is enabled by the device. For this purpose, the password is
encrypted and transmitted to the device, where it is checked.

3.1
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ii NOTE
The front USB port has a fixed IP address of 192.168.2.1 which is preconfigured in Reydisp Manager for USB
connection.

 

Requirements
The following requirements must be met for the steps described in further chapters:

• Product code
An offline configuration can only be transmitted to a device which uses the same product code as the
7SR5 device.

• Connection password
The connection and maintenance passwords are not active when the device leaves the factory or is
returned to the factory condition. If a connection password has been activated it will be required to allow
a configuration to be sent to the 7SR5 device. The passwords can be reset, from the device, to not active
using the Reset Passwords feature. This can be done using the default reset password 0000. If the
Setting ID Confirmation ID is active this must be known to reset the passwords.

• Physical connection
The Reydisp Manager 2 PC must be connected to the front USB port of the 7SR5 device. It is then not
necessary for communication connection parameters to be configured. If using a USB hub, then it may
not be possible to establish a communication connection between the Reydisp Manager 2 PC and the
7SR5 device.

Transmitting the Configuration to a 7SR5 Device for the First Time
When the device is delivered from the factory it will display a message intermittently on the fascia advising the
device is not configured. Changing any parameter setting from the fascia or sending a device configuration
file will remove this message. A message advising the IEC 61850 is not configured can only be removed if a
configuration setting is sent to the device. Before commissioning a device, you must as a minimum parame-
terize the device from the fascia. It is recommended that the device is fully configured from the Reydisp
Manager 2 PC software. In Reydisp Manager 2, initialization with a configuration associates the offline config-
uration with the 7SR5 device. For this, the 7SR5 device transmits its serial number, which is then entered in
the corresponding offline configuration.
 

Goal
The goal of this chapter is to create a 7SR5 device that is initialized with the offline configuration and is ready
for operation.
 

Sending Configuration
In the project tree, select the device of the offline configuration in question and in the device tasks select the
Load Device Configuration.

[sc_7SR5_ReydispManager2DeviceTasks, 1, --_--]

Figure 3-2 Reydisp Manager 2 Load Device Configuration Icon
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Click Load Configuration in device in the context menu and if the connection is made the Load Device
Configuration wizard will open.
Enter Next to proceed.
If the connection password is active the Enter Password dialog opens.
Enter the password.
Click OK.
The Enter Password dialog is closed.
Click Yes to confirm.
Initialization starts. Several indications inform the user about each status. Upon completion of initialization or
in case of failed initialization, a status dialog opens.
Click Finish.
The status dialog closes. After initializing, the 7SR5 device is restarted.

Transmitting a Configuration to 7SR5 Device in Service

ii NOTE
For any device configuration changes the offline file must be sent to the device. If this is required, device
data may be lost or become invalid due to configuration changes. The device data must therefore be
retrieved from the device prior to sending a new configuration.

ii NOTE
The date and time of the device clock will not be lost.

 

Sending Configuration
The device data must be first retrieved from the device as described in 3.4 Get Device Data.
The configuration can now be sent to the device.
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Change Device Template
Overview

When the device template is selected at the start of the engineering process, for example for directional over-
current protection, an application template is loaded. With this, the maximum functional scope of the 7SR5
device must be defined with a specific hardware and firmware configuration. In some situations it may be
necessary to change the configured device to a different firmware configuration by changing the template to
add additional functions available in a new device template.
It is often quicker to adapt an existing device than to start with a new device and configure it.

Changing a Device Application Configuration Template
This chapter describes how to change the device template.

[sc_7SR5_ReydispManager2ChangeDeviceTemplateIcon, 1, --_--]

Figure 3-3 Reydisp Manager 2 Change Template Icon

All necessary application templates must be installed for Reydisp Manager 2 to access or be available on the PC
to be directly pointed to using the Load Template from File option.

[sc_7SR5_ReydispManager2SelectingDeviceTemplate, 1, --_--]

Figure 3-4 Reydisp Manager 2 Selecting Device Template

3.2
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Select the MLFB of the device template that the device should be changed to.
Select the Minimum Firmware for the template and click Next.
Check the version number of the template and firmware are as required and click Next.
Select Finish and the new template will be imported and device changed.

[sc_7SR5_ReydispManager2ImportingDeviceTemplate, 1, --_--]

Figure 3-5 Reydisp Manager 2 Importing Template

During the import, any user information warnings of compatibility issues between the original template and
new template will be displayed. These messages are also logged in the Information messages tab for the
device.

[sc_7SR5_ReydispManager2ImportingDeviceTemplateUpdatingIEC, 1, --_--]

Figure 3-6 Reydisp Manager 2 Updating IEC 61850 Configuration

On completion the MLFB and template version can be checked by viewing the Device Properties
General tab in the Device configuration section of the Tasks area for the device.
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[sc_7SR5_ReydispManager2Properties, 1, --_--]

Figure 3-7 Reydisp Manager 2 Properties Icon

[sc_7SR5_ReydispManager2DeviceGeneralProperties, 1, --_--]

Figure 3-8 Reydisp Manager 2 Device General Properties

All user configured data will be transferred to the offline device configuration where compatible.
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Install Device Firmware
Overview

When ordering a device, the hardware and certain functional characteristics are selected with the latest
released firmware for the chosen model.
 

Device Firmware Version
The firmware can be viewed in the device on the fascia in Device Information:

• > Firmware Version – Device firmware

• > Comms FW Version – Communication and security firmware

• > Config Version – Default configuration scripts

 

Functional Characteristics
The base application functional specification is fixed by the order code but the functional characteristics may
vary with firmware changes. The firmware can be updated in a 7SR5 device to match the firmware in the
Reydisp Manager template using the device task function.
For firmware upgrades the install package should be downloaded from the website. A self extracting package
is provided which will provide Reydisp Manager Templates. This allows the installation of Reydisp Manager 2
templates including firmware.
The firmware upgrade package will include an update to the firmware and configuration files.
In addition to the firmware upgrades, security update patches may be required throughout the life of the
device if vulnerabilities are identified. Such security patch firmware will be released independently from the
firmware and will update the Comms Firmware only.
The security updates will be available to download from the website.

ii NOTE
Siemens advise that the latest security firmware is always installed.

Installing the New Firmware Templates to Reydisp Manager
Reydisp Manager 2 must be installed on the PC to ensure the correct USB drivers are installed.
Clicking the self extracting .exe file will load the files into the Reydisp Manger templates location.
For a new device follow the instructions in 2.2 Starting Reydisp Manager 2 and Creating a Project and
2.4 Adding a 7SR5 Device. When selecting the template in Figure 2-23, select the version for this upgrade.
If the device is already existing within a project, the instructions procedure in 3.2 Change Device Template
must be followed to upgrade the device to the new firmware template.
 

Firmware upgrade procedure
The device should be out of service and disconnected from the power system.
Any configuration and data stored in the device will be lost during a firmware upload.

Loading Device Firmware to the 7SR5 Device
The device must be connected to the PC via the front USB port.
The PC will connect to the device and proceed to transfer the firmware package to the device.
Double-click the Install Device Firmware in the selected device task area.

3.3

Device Tasks
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[sc_7SR5_ReydispManager2InstallDeviceFirmware, 1, --_--]

Figure 3-9 Reydisp Manager 2 Install Device Firmware Icon

ii NOTE
If the maintenance password is active a prompt window will request that it is entered before continuing.

[sc_7SR5_ReydispManager2FirmwareVersion, 1, --_--]

Figure 3-10 Reydisp Manager 2 Firmware Version

Confirm the firmware is the correct version by selection and click Next to continue.
A loader window will be visible for a short duration during the connection.
On completion of the transfer the window will notify the user the upload from the PC to the device is
complete and the Finish option must be selected.
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[sc_7SR5_ReydispManager2FirmwareUploadComplete, 1, --_--]

Figure 3-11 Reydisp Manager 2 Firmware Upload Complete

During the upgrade process the device fascia will display file transfer information and the device will restart on
completion.
All user configuration files and data storage will be erased and the settings defaulted. Press Enter on the
device to confirm acknowledgement. The device will display the Device not configured message on the
display after a short duration.
The firmware version can be viewed in the device on the fascia in Device Information for confirmation.

Loading a Security Update Comms Firmware to the 7SR5 Device
Download the security patch to the PC.
The device should be out of service and disconnected from the power system.
Browse to the device homepage of the device via a direct connection to the USB port or over an ethernet
connection to one of the rear ethernet ports of the device.
For the device front USB port use https://192.168.2.1/upload to navigate directly and procced to the
page.
For the rear ethernet port, it must be configured and the IP address used.
Use the Choose file option to navigate to the security patch .pck file downloaded from the website and
select Update.

ii NOTE
If the maintenance password is active a prompt window will request that it is entered before continuing.
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[sc_7SR5_ReydispManager2SecurityUpdate, 1, --_--]

Figure 3-12 Reydisp Manager 2 Security Update

When the update is complete the device will restart.

ii NOTE
The user configuration files and data storage files will not be erased during a security patch update.
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Get Device Data
Overview

The device stores data that can be viewed and analyzed on the PC.
The following data files can be retrieved from the device using Reydisp Manager 2:

• Waveform records storage

• Fault records storage

• Event log
When retrieved from the device the files will be associated with the device in the project and stored on the PC
using the time and date of the file as the default name.

Get Device Data
The device data can be retrieved from the device using Device Task > Get Device Data when
connected to the fascia USB port.

ii NOTE
Any passwords configured in the device may be required to access the data.

[sc_7SR5_ReydispManager2GetDeviceDataIcon, 1, --_--]

Figure 3-13 Reydisp Manager 2 Get Device Data Icon

ii NOTE
An error message will be provided if the data can not be retrieved for any reason.

ii NOTE
The Get Data will check for all file types and if none are available will complete the action successfully.

An error message is not given if there are no files available but the device was checked successfully.
Alternatively an icon is located on the right hand side of the device details which can be selected to get the
device data for that particular device.

[sc_7SR5_ReydispManager2GetLogsandRecords, 1, --_--]

Figure 3-14 Reydisp Manager 2 Get Logs and Records

A connection window is provided to select between the default USB connection method and connecting via
the rear Ethernet port using the IP address of the device.

3.4
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[sc_7SR5_ReydispManager2ConnectByUSB, 1, --_--]

Figure 3-15 Reydisp Manager 2 Communication Settings
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• Waveform Records
Any available waveform records will be retrieved from the device from both the buffer storage and the
archived memory. The files will be stored under the Device Data tab using the waveform time and
date as the default file name and also the last modified information.

[sc_7SR5_ReydispManager2DeviceDataWaveformRecords, 1, --_--]

Figure 3-16 Reydisp Manager 2 Waveform Records

The file name can be changed by the user by a right-click of the mouse on the waveform record and
entering the preferred name followed by Apply.

[sc_7SR5_ReydispManager2WaveformRecordRename, 1, --_--]

Figure 3-17 Reydisp Manager 2 Waveform Record Rename

The maximum quantity associated with the device will only be restricted by the PC memory capacity.
The file can be exported and saved to a Reyrolle waveform record format, .rdf2 by right-clicking on the
waveform record file in the device data window.
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• Device Event Records
When the device data is retrieved from the device a new Event log is created on the PC containing the
last recorded events in the device since the Event log was last reset. The same events may be visible in
multiple event logs. The files will be stored under the Device Data tab using the time and date when
the Event log was created as the default file name and also the last modified information.

[sc_7SR5_ReydispManager2DeviceDataEventLogs, 1, --_--]

Figure 3-18 Reydisp Manager 2 Event Logs

The file name can be changed by the user by a right-click of the mouse on the event log, selecting the
Rename Event Log and entering the preferred name followed by Apply.

[sc_7SR5_ReydispManager2DeviceDataEventLogsRename, 1, --_--]

Figure 3-19 Reydisp Manager 2 Event Log Rename

ii NOTE
Event records will be reset when a new device configuration is sent to the device or the firmware is rein-
stalled.

The event log can be exported by a right-click of the mouse on the event log file. The file is exported as a .txt
file.
When viewing the event log file the order of the events can be sorted by the timestamp by clicking the time-
stamp heading which will switch between the earliest date and latest date at the top of the list.
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• Fault Record Logs
Any available fault logs will be retrieved from the device.
The files will be stored under the Device Data tab using the device fault logs time and date as the
default file name and also the last modified information.

[sc_7SR5_ReydispManager2DeviceDataFaultLogs, 1, --_--]

Figure 3-20 Reydisp Manager 2 Fault Logs

The file name can be changed by the user by a right-click of the mouse on the Fault log, selecting the
Rename Fault Log and entering the preferred name followed by Apply.

[sc_7SR5_ReydispManager2DeviceDataFaultLogData, 1, --_--]

Figure 3-21 Reydisp Manager 2 Fault Log Data

The Fault log displays the time and date when the fault was stored, with the active setting group and
measured values in the device at the time of the fault.
The faults can be sorted by date by clicking the timestamp heading.
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Get Device Configuration
Overview

The device configuration held within the device can be extracted and stored in the device project. The device
must be included within the project. The Get Device Configuration function will extract the following
user files and import them into the project automatically:

• Function configuration

• Serial Comms & Events

• User logic

• HMI screens

• User curves

• Ethernet Interface parameters

• Ethernet time zone
The file information in the project will be updated with the date and time from the extracted files.
The properties of the device will also be updated with the serial number of the connected device.
As the user settings within the device parameter file can be edited from the device fascia, these values will be
compared with those held already within the project and the user prompted to agree or ignore the imported
values.

Get Device Configuration
The complete user configuration files can be extracted by selecting the specific device and using the Get
Device Configuration icon in the device tasks working area for that device.

[sc_7SR5_ReydispManager2GetDeviceConfiguration, 1, --_--]

Figure 3-22 Reydisp Manager 2 Get Device Configuration Icon

Alternatively an icon is located on the right hand side of the device data for that particular device.

[sc_7SR5_ReydispManager2GetDeviceConfigurationOption2, 1, --_--]

Figure 3-23 Reydisp Manager 2 Get Device Configuration Icon Alternative

Double clicking on one of the available icons will open a connection window, the default connection is a direct
connection from the PC to the front USB port.

3.5
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[sc_7SR5_ReydispManager2ConnectionWindow, 1, --_--]

Figure 3-24 Reydisp Manager 2 Connection Window

At this stage the user must also select between getting the complete device configuration, which will update
all of the user configuration files in this device in the project or to only extract the user settings contained in
the device parameter file.

ii NOTE
Both options allow the user to confirm any differences between the user setting values before overwriting
the files in Reydisp Manager.
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[sc_7SR5_ReydispManager2ConnectionWindow, 1, --_--]

Figure 3-25 Reydisp Manager 2 Get All User Configuration Files
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[sc_7SR5_ReydispManager2OnlyUserSettings, 1, --_--]

Figure 3-26 Reydisp Manager 2 Get Only User Settings

All files that are changed in the project will have the last modified information updated to reflect the date
when that file was last changed.

ii NOTE
If the last modified timestamp on the file in the device was earlier than the one on the PC the timestamp
will show the earlier timestamp and not the timestamp of the upload from the device.

The connection will first confirm that the device you are connected to is the correct device associated with this
project and report any incompatibility with an information or error message and stop the download process.
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[sc_7SR5_ReydispManager2CheckingDevice, 1, --_--]

Figure 3-27 Reydisp Manager 2 Checking Device

Failure messages will be displayed in the window, an example of this is shown in Figure 3-28.

[sc_7SR5_ReydispManager2FailureMessage, 1, --_--]

Figure 3-28 Reydisp Manager 2 Example Failure Message

If the option for getting the device setting values only has been selected, even if the devices are not of the
same type, a warning message is given and the task will continue. The setting values will still be imported for
comparison and use.
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[sc_7SR5_ReydispManager2CheckingComplete, 1, --_--]

Figure 3-29 Reydisp Manager 2 Check Complete

On completion of a complete device import the user is prompted with the time and date of the last configura-
tion update on the device and must confirm if they wish to proceed and overwrite the configuration on the PC
or keep the existing PC files and stop the import.

[sc_7SR5_ReydispManager2ImportConfiguration, 1, --_--]

Figure 3-30 Reydisp Manager 2 Import Configuration

Any differences between the setting values in the parameter file on the connected device and the values in
the file contained in the PC project will be listed in the Merge Settings window. The view can be changed
to only show the values with differences by selecting the option Show differences only.
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[sc_7SR5_ReydispManager2ShowDifferencesOnly, 1, --_--]

Figure 3-31 Reydisp Manager 2 Show Differences Only

Using the Next button the user can cycle through the differences. The user can choose to keep the setting in
the PC project file or transfer the setting from the connected device to update the project file by using the
arrow key.
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[sc_7SR5_ReydispManager2UpdatingProjectFile, 1, --_--]

Figure 3-32 Reydisp Manager 2 Updating Project File

Device Tasks
3.5 Get Device Configuration

136 Reyrolle 7SR5, Engineering Guide, Manual
C53000-G7040-C013-1, Edition 04.2020



Set Device Date and Time
Overview

The device date and time can be set on the device fascia using the menu keys or from the Set Device Date
and Time function within the device tasks. This can be useful during test and commissioning when the
substation clock is not available or connected to the system as it will provide a useful time stamp on the data
records in the device.

Set Device Date and Time
The device task operations for each device includes the option to Set Device Date & Time.

[sc_7SR5_ReydispManager2SetDeviceDateandTime, 1, --_--]

Figure 3-33 Reydisp Manager 2 Set Device Date and Time Icon

Double clicking the icon opens a time setting window to select the preferred source of the time to be sent to
the device. The default option is to use the time from the PC as the source but an option is also available to
manually enter a preferred time and date.

[sc_7SR5_ReydispManager2TimeSettings, 1, --_--]

Figure 3-34 Reydisp Manager 2 Configure Device's Time Settings

The window also includes the connection options available, with the default connection selected as a direct
connection from the PC to the front USB port and an option to select an IP address for ethernet connection.
The Set Time button is clicked to send the time and date to the device.
The Get Time button will retrieve the time and date from the device to confirm the time is correct, the time
retrieved from the device will be shown in the Time Settings area of the window.

ii NOTE
If the connection password is active this must be entered to proceed with this action.
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[sc_7SR5_ReydispManager2GetTime, 1, --_--]

Figure 3-35 Reydisp Manager 2 Get Time
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Compile IEC 61850 Configuration
When the System Configurator is closed, the IEC 61850 configuration of each 7SR5 device assigned to
that station is recompiled. This can take a while if a large number of devices is assigned to a single station.
The IEC 61850 configuration will always be updated automatically before any attempt is made to synchronize
the device and can be manually recompiled by clicking Update Station from the task pane.
If something has changed that affects the IEC 61850 configuration, the IEC 61850 configuration will require
updating.

[sc_7SR5_ReydispManager2UpdateStation, 1, --_--]

Figure 3-36 Reydisp Manager 2 Update Station
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Export ICD
A device ICD file can be exported for use in another vendor's IEC 61850 configuration tool. To do this the user
must select the device to export in the project and click Export ICD from the task pane. The exported ICD
file will contain the IED name.
An ICD file can be exported from the device template prior to configuration but it is recommended as a
minimum the Function Configuration is checked prior to the export.
A window will pop up to select the location the file should be saved to and what it should be called.

4.1
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Import SCD/ICD
Overview

A single 7SR5 device may be configured externally for IEC 61850 communications by a tool which produces a
CID (Configured ICD File) or an SCD file. A CID file is an SCD file but only contains information relevant to a
single device instead of every device in the station.
A CID file can be exported from the System Configurator.
Assigning a station to a single device is called a Local Station. A local station is only ever assigned to a
single device therefore it does not show up in the project as a station because its assignments cannot be
changed.
The SCD/CID import is used in the following scenario:
Another vendor's tool is used to configure a station. The tool imports the 7SR5 device ICD and configures the
station to use the 7SR5 device. In this scenario, we need the station configuration to also be applied to the
7SR5 device in Reydisp Manager so both the vendor's tool and Reydisp Manager are using the same device
configurations to enable the devices to communicate over the network.
The following is a likely scenario:
1. A project is created in Reydisp Manager and a 7SR5 device is added. The ICD for this device is exported.
2. Another vendor's tool is used to configure the station (SCD file). To configure the station, the tool needs to
import the 7SR5 device before it can configure it.
3. The ICD is added to the station, and the station is configured, including IP configuration and GOOSE
mappings.
4. The SCD (or CID) is exported from the vendor's tool.
5. The CID/SCD file is imported to the device in Reydisp Manager. This creates a local station using the configu-
ration information in the CID/SCD file. It's IP address has been set and any GOOSE messages have been setup.
The configuration can now be sent to the device and it will be fully configured for IEC 61850 communications
with the other devices in the station.
6. If a CID file is used, which only has a single device, the IED name of the device will be changed to match the
IED name in the CID file.
7. If an SCD file is used, the IED name of the device must match up with the IED name of the device in the SCD
file.
8. If the device is already assigned to a local station, performing a CID/SCD import will replace the local station
with a new local station.
9. If the device is already assigned to another station, the import cannot be performed. Remove the device
from the station first and try the import again.

Importing SCD/CID File
In order to create a new device in Reydisp Manager the user must change the configuration - logic, settings,
IEC 61850 interface or time zone as required. The user must:

• Update the device name and IED name as required

• Select the device and select Import SCD/CID from the task pane

• Import the ICD into the vendor's tool

• Add it to the SCD and configure the device IP settings, GOOSE messages etc. (In this example, we have 3
devices from other vendors plus 1 7SR5 device in the SCD).

• Export the SCD from the vendor's tool

• Create a station in Reydisp Manager

• Select the station and click Import SCD from the task pane

4.2
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Export IEC 61850 MICS
Overview

The Export IEC 61850 MICS feature provides the user with the Model Implementation Conform-
ance Statement directly from device configuration to provide an exact statement in accordance to the
users particular configuration.

[sc_7SR5_ReydispManager2ExportIEC61850MICS, 1, --_--]

Figure 4-1 Export IEC 61850 MICS Icon

The feature will generate the MICS file and request the user to save either an RTP or HTML file using a
preferred name and location.

[sc_7SR5_ReydispManager2PreparingIEC61850MICS, 1, --_--]

Figure 4-2 Exporting IEC 61850 MICS Message

An example of the HTML file is shown in Figure 4-3. This format provides the user with a structured document
with hyperlinks to the various sections.

[sc_7SR5_ReydispManager2HTMLFile, 1, --_--]

Figure 4-3 Reydisp Manager 2 Example HTML File
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[sc_7SR5_ReydispManager2MICS, 1, --_--]

Figure 4-4 Reydisp Manager 2 Example Detailed HTML File
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Export IEC 61850 SNTP
A Simple Network Time Protocol (SNTP) is a time server that other devices can synchronize their clock time
with.
A SNTP server is usually added to the project via the System Configuration tool and is outside of the
scope of Reydisp Manager 2.
To export a template SNTP ICD file the Tools menu provides an Export IEC 61850 SNTP option which in
turn provides a save as feature for saving to a specific location and naming the file.

4.4
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